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Introduction to WizManager

Welcome to WizManager !
WizManager is a powerful "add-on" which greatly extends Windows' File Manager capabilities. It 
appends many features missing in File Manager, and enhances your power to manage your disks and 
files.    WizManager is automatically loaded when File Manager starts and is removed from memory 
when the latter closes.    You do not have to intervene -- once installed, WizManager becomes entirely 
part of File Manager, just like standard features.

The WizManager additions are multi-faceted and can be categorized as belonging to four main sets of 
powerful tools:

 Fast Access Buttonbar 
 Launchbar 
 Utilities 
 Command Line Box 

WizManager is the result of listening to the wishes of many File Manager users and implementing those
suggestions into a totally compatible software package.    Many of WizManager's features have 
repeatedly been asked for in the past and are now made available to you.    With WizManager, using 
File Manager becomes easier, more useful and much more enjoyable.    

See also:
Quick Tips 
Buttonbar
Launchbar
Command Line Commands    



Quick Tips

Here are a few quick tips to get you started or to give you some indications on how to use 
WizManager more efficiently.

WizManager Buttonbar
The Buttonbar is a set of shortcuts to the File Manager menu commands and to the WizManager 
features. Clicking with the left mouse button on any button will immediately start the corresponding 
command. Files and directories can also be dragged and dropped onto the Buttonbar. The activated 
button on which the files and directories were dropped will automatically launch the corresponding File 
Manager or WizManager command. 

Depending on your system video resolution, ten (VGA 640x480 pixels), nineteen (SuperVGA 800x600 
pixels), twenty six (SuperVGA 1024x768 pixels) or thirty six (SuperVGA 1280x1024 pixels) icons can be
simultaneously displayed in the Buttonbar. The higher the resolution, the more icons you have available
without scrolling.

Scroll the Buttonbar? 
What is this button? 
Change the order of the buttons, remove buttons? 
Specify the number of buttons displayed and the number of buttons scrolled? 

WizManager Launchbar
The Launchbar is a powerful tool and is like a Program Manager built-into File Manager. It allows you to
set buttons which will automatically launch DOS and Windows programs or open files. Files can also be
dragged and dropped onto the Launchbar. The application corresponding to the button to which the files
were dropped to will automatically open the files.

If the Launchbar is not displayed at the top of File Manager, select Launchbar from the Display/Hide 
menu in the WizManager menu. 

Like for the Buttonbar, your video resolution limits the number of buttons displayed simultaneously in 
the Launchbar (i.e. there are more buttons available 'behind' the set displayed). To access the rest of 
the buttons, simply scroll the Launchbar. 

Scroll the Launchbar? 
What is this button? 
Customize Launchbar, add buttons? 
Specify the number of buttons displayed and the number of buttons scrolled? 

    

Command Line Box
The Command Line Box is displayed at the left side of the Buttonbar. The caret of the Command Line 
Box edit field is blinking when the Command Line Box is active and ready to receive your commands. 

Quickly switch to the Command Line Box? 
What is displayed above the Command Line Box? 
What commands? 
Repeat commands? 
 



Interrupt a command? 
Work with the files displayed in File Manager directory window? 
Access DOS internal commands? 
Same name? 

Utilities
With WizManager, you also get many utilities. Below you will find hints on what you can do with some of
them:

Do you frequently use certain commands or applications?    
Do you wish to quickly minimize all running applications or see which ones are running?     
Do you need your system information or disk(s) information? 
Do you wish to start multiple files or start a file which doesn't have an association?     
Do you want to print the directory listing displayed in File manager?    
Is your disk full, but you have to find some room for an additional program?     
Do you have to leave your station but you don't want anyone to see or touch your data while you are 
gone, and you don't want to turn your computer down?     

There are many more utilities like exiting or restarting Windows, rebooting your system, accessing the 
different Control Panel functions directly, etc. As you use WizManager, you will quickly familiarize 
yourself with most of them and enjoy the WizManager functionalities. 

See also:
Introduction to WizManager 



WizManager Command Line Box

The Command Line Box, located on the left of the Buttonbar, is much more than the simple Run 
command found in the File menu. Most DOS internal commands and many external commands 
have been implemented in WizManager itself and are available directly within File Manager.

Because the Command Line Box is part of File Manager, all WizManager DOS commands, like COPY, 
DEL, ATTRIB, etc., are executed in Windows, without shelling out to DOS. The result could be called 
DOS in Windows: it is fast, convenient and powerful. With WizManager Command Line Box, you get 
the best of    both worlds:    Windows and DOS.

The caret of the Command Line Box edit field is blinking when the Command Line Box is active and 
ready to receive your commands. 

Quickly switch to the Command Line Box? 
What is displayed above the Command Line Box? 
What commands? 
Repeat commands? 
 

Interrupt a command? 
Work with the files displayed in File Manager directory window? 
Access DOS internal commands? 
Same name? 

See also:
Command Line Box Commands    
WizManager Buttonbar 
WizManager Launchbar
    



WizManager Buttonbar

WizManager's Buttonbar gives you a quick way to execute File Manager and WizManager 
commands. You don't need to browse through the different menus, all File Manager and 
WizManager functions are right under your finger. Click with the left mouse button on any 
button and the corresponding command will immediately start. You can also drag and drop files 
and directories to the Buttonbar.    The activated button on which the files and directories were 
dropped will automatically launch the corresponding File Manager or WizManager command.

If the Buttonbar is not displayed at the top of File Manager, select Buttonbar from the Display/Hide 
menu in the WizManager menu. This command allows you to display or hide the Buttonbar and the 
Command Line Box.

Your video resolution limits the number of buttons displayed simultaneously in the Buttonbar (i.e. there 
are more buttons available 'behind' the set displayed). To access the rest of the buttons, simply scroll 
the Buttonbar. 

Scroll the Buttonbar? 
What is this button? 
Change the order of the buttons, remove buttons? 
Specify the number of buttons displayed and the number of buttons scrolled? 

 

See also:
Customize Buttonbar
WizManager Launchbar
Command Line Box 



Popup Menu

WizManager's popup menu is displayed when you click with the right mouse button on File 
Manager. The popup menu provides a fast way for accessing useful features, and is divided into
four sections. It displays your customized launch menus, file command menus, task command 
menus and a list of all the tasks currently running in Windows. 

You can choose from the Preferences dialog which popup menu sections should be displayed in the 
popup menu.

The popup menus are:

Launch Displays your customized menu items.
Customize Launch Menus... Opens the Customize Launch Menus dialog.
______________________________________________________

Copy... Activates the Copy command.
Move... Activates the Move command.
Delete... Activates the Delete command.
Rename... Activates the Rename command.
Print... Prints the selected files.
Properties... Displays file and directory properties.
Create Directory... Allows you to create a new directory.
Select Drive... Allows you to switch to another drive.
View Files... Launches the file viewer application.
Open Files... Activates the WizManager Open command.
Zip Files... Compresses the selected files.
UnZip File... Expands files from the selected archive.
______________________________________________________

Minimize All Applications Minimizes all running applications.
Restore All Applications Restores all running applications.
Close Applications... Prompts before closing each running application.
Task Manager Opens Windows Task Manager.

The last section of the popup menu, the task list, displays all the currently running applications. If you 
wish to switch to one of the running applications, simply select it from the tasks list.    If you wish to 
close one of the running applications listed, hold the Ctrl key down and select the application from the 
tasks list.

Hidden tasks can be included in the tasks list. Check the appropriate option in WizManager's 
Preferences.

See also:
Quick Tips 



Technical Support

Questions? Problems? Suggestions?

We would like to hear from you if you have any questions, problems,    suggestions, or special requests 
regarding WizManager.

The WizManager User Manual and this Help file have answers to the most commonly asked questions. 
Try to browse quickly through these sources of information, you should find it useful.

If your questions or problems cannot be answered by the manual or help file, or if you have any 
suggestions, please contact Mijenix Corporation through one of the following channels:

Mijenix Corporation
6666 Odana Rd, Ste 326
Madison, WI 53719
USA

Tel & Fax : (608) 277-1971
CompuServe : 74774,564
America Online : Mijenix
Internet : 74774.564@compuserve.com
    

Join us on CompuServe (GO MIJENIX) where we host the MIJENIX Section of the Windows Vendor 
Forum. There, you can download updated files and evaluation versions, and post your questions 
to our technical staff.    If you are not a CompuServe member, we will be happy to offer you a free 
CompuServe Introductory Membership, plus a $15.00 CompuServe usage credit.

Due to the oftentimes complex technical nature of WizManager or Windows configurations, 
technical support by phone is not the most effective and almost always results in a request for 
follow-up information. Please use one of the other means whenever possible and send us a 
detailed description of your problem. We will address your concerns promptly.    Thank you.

See also:
Quick Tips 
Command Line Box Commands 



Purchasing the Software

Our products can be purchased from us directly (Mijenix Corporation) or from a vendor in your country if
a representation exists.    For site licenses, please consult the file SITE_LIC.WRI.    For volume 
discounts, please contact Mijenix Corporation.

Licensing our products brings you wonderful benefits.    Some of these are:

You receive the full-featured, registered and enhanced version of the product (Professional User's
Guide manual also included for some of the products). 

You get rid of that pesky reminder window that comes up when you start the software.
You are entitled to one hour free phone support for 90 days (your dime).
You receive new product information and are entitled to special upgrade offers.
You allow us to continue developing products that make your life easier.
You protect yourself legally from a software license audit.

Our great line of Windows products includes:

WizManager Transforms Windows File Manager into the most powerful file management 
system available in Windows.    You get File Viewers, built-in Zip/UnZip, a 
Buttonbar to quickly access all the File Manager and WizManager commands, a 
Launchbar to start any DOS or Windows application with a simple mouse click, 
Super File Finder, Duplicates Finder, Directory Comparison, Directories Size 
Browser, DOS Command Line Box ... and much more.    $29.95

WizManager Pro Includes WizManager + WizUtilities Pak + a 175-page User's Guide. A super 
deal for only $39.95

WizUtilities Pak Includes the power utilities you need in one advantageous package: WizViewer +
WizZipper + WizFinder + WizDuplicates + WizSynch + WizLock.    $ 29.95

WizViewer Lets you see the contents of your documents, spreadsheets, databases, ClipArt, 
etc. quickly and without having to load the programs that created them!    $15.00

WizZipper Makes it easy to compress and extract ZIP files. This powerful utility also 
provides multiple-volume support (disk-spanning) and encryption/decryption of 
ZIP file items.    $15.00

WizFinder Helps you find any file or directory on any drive. With WizFinder you can retrieve 
a file even if you just know one word contained in the file or only know an 
approximate date or hour when the file was created.    $15.00

WizDuplicates Helps you recover precious disk space by finding all the duplicate files present on
one or more of your drives. You'll be surprised at how much disk space you'll 
regain after cleaning up with WizDuplicates.    $15.00

WizSynch This utility can compare and synchronize two directories quickly and easily. It lets
you understand the possible differences between the two directories and easily 
update contents.    $15.00

WizLock WizLock lets you safely lock Windows so that you can leave your computer 
knowing that nobody will "play" with your files or programs. When you come 
back, type your password and you'll find everything just the way you left it.    
$15.00



Click on the appropriate vendor name to display purchasing information and optionally print an 
order form.

Representation: Vendor:
USA and International Mijenix Corporation (the author) 
Australia Share Warehouse Australia Pt. Ltd 
Austria/Osterreich Pearl Agency Osterreich 
France WindowShare SARL 
Germany/Deutschland Der PD-PROFI or Pearl Agency Deutschland 
Japan P. & A. Co., Ltd 
New Zealand Share Warehouse New Zealand Ltd
Switzerland/Suisse/Schweiz Pearl Agency Schweiz 



Mijenix Corporation Order Form

Click here to print an order form 

Name: ___________________________________________________________
Company (if applicable):    __________________________________________________
Street: ___________________________________________________________
City: _____________________________ State: _____ Zip:    _____________
Country: __________________ Tel: ________________ Fax: ________________

For Site Licenses, please consult the file SITE_LIC.WRI or contact Mijenix Corporation.

____    WizManager:

    Standard @ $29.95    : ________

    PRO @ $39.95    : ________
____    WizUtilities Pak @ $29.95    : ________
____    WizViewer @ $15.00    : ________
____    WizZipper @ $15.00    : ________
____    WizFinder @ $15.00    : ________
____    WizDuplicates @ $15.00    : ________
____    WizSynch @ $15.00    : ________
____    WizLock @ $15.00    : ________

Shipping & Handling: USA/Canada $    5.00
International $12.00    : ________

Subtotal: $      ________
Wisconsin residents add 5.5% sales tax: ________

TOTAL: $      ________
Payment by: __ Check (US) __ Certified Check (US) __ Money Order (Intern'l) 

__ Mastercard __ Visa * Please, no Eurocheques *
Card #: _________________________________________  Exp. Date:   ____________
Signature: _____________________________________________________________
Cardholder Name: _______________________________________________________
Where did you hear of, or receive a copy of our product(s)?



Send to: Mijenix Corporation
6666 Odana Road, Suite 326
Madison, WI 53719   USA

or call: Tel: (608) 277-1971
FAX: (608) 277-1971

or email: CompuServe: 74774,564
Internet: 74774.564@compuserve.com
AOL: mijenix

Mijenix products can also be ordered through the following US company:
Public Software Library (PsL)
Sales: 1-800-242-4775 or (713) 524-6394
(VISA, MasterCard, AMEX and Discover accepted by PsL)
IMPORTANT: The PsL numbers above are exclusively for placing orders by phone with credit 
cards. Mijenix Corp. CANNOT be reached at those numbers. If you have questions about the status
of your order, site licenses, etc, please contact Mijenix Corporation directly.

Several international dealers, US dealers and computer stores also carry our products. Ask your 
favorite vendor about our products.

* Please allow 1 - 2 weeks for delivery



Commandes en France

Clicker ici pour imprimer cette information 

Pour des commandes en France, consultez:

WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France

Fax: (+33) 87 32 37 75
Vox: (+33) 87 30 85 57
Minitel 3615 WinShare



Bestellungen in Deutschland

Bitte hier drücken für einen Ausdruck dieser Information 

Deutsche Benutzer nehmen bitte Kontakt auf mit:

DER PD-PROFI
Gerd Zöttlein
Schulstrasse 13
D - 86666 Burgheim
Germany/Deutschland

Tel: (49)-8432-1296
Fax: (49)-8432-8674
CompuServe: 100326,53

Oder:

Pearl Agency Deutschland
Am Kalischacht 4
D-79426 Buggingen

Tel:    076 31 360 200
Fax: 076 31 360 444



Ordering in Australia

Click here to print this information 

Users from Australia, please contact:

SHARE WAREHOUSE AUSTRALIA Pty.LTD
Suite 32, Level 4, 301 Castlereagh Street
Sydney, NSW 2000
AUSTRALIA

Phone: (02) 211-1304
Fax: (02) 211-1304



Ordering in Japan

Click here to print this information 

Japanese users, please contact:

P. & A. Co, Ltd
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196
JAPAN

Phone: 0425-46-9141
Fax: 0425-46-9142
NiftyServe ID:    PAF02461



Ordering in New Zealand

Click here to print this information 

Users from New Zealand, please contact:

SHARE WAREHOUSE NEW ZEALAND LTD
PO Box 13-489
Johnsonville, Wellington 6004
NEW ZEALAND

Phone: (04) 477-3535
Fax: (04) 477-3535
Mobile phone: 025-452-598



Bestellungen in Osterreich

Bitte hier drücken für einen Ausdruck dieser Information 

Osterreichische Benutzer nehmen bitte Kontakt auf mit:

Pearl Agency Osterreich
Steyrerstr. 40
A-4540 Bad Hall
Osterreich

Tel:    072 58 53 33
Fax: 072 58 53 15



Commandes en Suisse - Bestellungen in der Schweiz

Clicker ici pour imprimer cette information 

Bitte hier drücken für einen Ausdruck dieser Information 

Pour des commandes en Suisse, consultez:
Fuer Bestellungen in der Schweiz bitte Kontakt aufnehmen mit:

Pearl Agency Schweiz
Grossmattstr. 16
CH-8964 Rudolfstein
Suisse/Schweiz

Tel:    (057) 31 70 20
Fax: (057) 31 70 30



WizManager Utilities and Tools

WizManager not only adds a Buttonbar, a Launchbar and a Command Line Box to File Manager, it also 
comes with a large selection of utilities and tools.

View Files View File Contents.
Open Files Open Files Your Way.
Zip, UnZip, Open Zip File Compress, Expand Zip files.
Find Files Find any File or Directory.
Find Duplicates Find Duplicate Files on Your Drives.
Synchronize Directories Synchronize Two Directories Contents.
Directories Size Browser Display the Size of Directories.
Set Files Date/Time Modify the Date and Time of Files.
Lock Lock Your System.
Print Directory Print Listing of the Files in a Directory.
Print Tree Print a Disk's Directory Tree.
Disk Info Display Disk Information.
System Info Display Your System's Configuration.
Exit, Restart, Reboot Exit, Restart Windows or Reboot System.



Launchbar

The Launchbar is a powerful tool and is like a Program Manager built-into File Manager. It allows
you to set buttons which will automatically launch DOS and Windows programs or open files. 
Files can also be dragged and dropped onto the Launchbar. The application corresponding to 
the button to which the files were dropped to will automatically open the files.

If the Launchbar is not displayed at the top of File Manager, select Launchbar from the Display/Hide 
menu in the WizManager menu. 

Your video resolution limits the number of buttons displayed simultaneously in the Launchbar (i.e. there 
are more buttons available 'behind' the set displayed). To access the rest of the buttons, simply scroll 
the Launchbar. 

Scroll the Launchbar? 
What is this button? 
Customize Launchbar, add buttons? 
Specify the number of buttons displayed and the number of buttons scrolled? 

See also:
Customize Launchbar    
WizManager Buttonbar
Command Line Box 



Customize Launchbar

Select Customize | Launchbar from the WizManager menu to access the Customize Launchbar 
dialog.

The Customize Launchbar dialog allows you to reorganize the Launchbar's button order, add or remove
buttons, set the number of buttons displayed, and specify the number of buttons scrolled per scroll 
increment.    You can also specify the respective position of the Launchbar in File Manager with respect 
to the Buttonbar, and specify if you wish to display the Launchbar with small buttons/icons.

To reorganize/customize your Launchbar:

To optimize your work with the Launchbar, move the most often used buttons to the beginning of the 
Launchbar and the least often used to the end. 

To move a button, simply drag and drop it to its new location using the mouse. 
To add a button in the Launchbar, select the New Button button. 
To modify a button, click on it in the Launchbar. A Modify Launchbar Button dialog will be 

displayed which lets you customize the buttons description, action and icon.
To remove a button from the Launchbar, click on it and then select the 'Delete Button' button in 

the displayed dialog.

To modify the number of buttons displayed:

If you are not using File Manager in its full width, it is necessary to reduce the number of buttons 
displayed in the Launchbar in order to have access to all the buttons when the Launchbar is scrolled. 
Select the number of buttons which should be displayed in the Launchbar from the number of buttons 
displayed per button page list.

To modify the number of buttons scrolled:

When the Launchbar is scrolled, WizManager refreshes as many buttons as are displayed in the 
Launchbar (button page). However, it is possible to reduce the number of buttons scrolled each time by 
selecting the desired number from the scroll increment list.

To position the Launchbar :

With the Display Launchbar above the Buttonbar check box, you can specify whether the Launchbar or 
the Buttonbar should be the topmost bar displayed. Check the box if you wish to have the Launchbar as
the first bar and uncheck it if you wish to have the Buttonbar as the first bar in File Manager.

To set the size of the button:

With the Use small buttons in Launchbar check box, you can specify whether the Launchbar should 
display its buttons in normal full size or if it should reduce the buttons and their icons/pictures. Check 
the box if you wish to have the Launchbar with small buttons.
Note:    The small button icons are obtained from the regular icons with a reduction process. This 
procedure is not instantaneous and if the Launchbar contains a lot of buttons, File Manager's startup 
time can be slightly increased when small buttons are used.

See also:
Modify Launchbar Button    



Commands - Alphabetical Index

386 Optimizes Windows for 386 Enhanced Mode.
About Displays WizManager About Dialog.
Associate Associates a File with an Application.
Attrib or AttribQ Changes or Displays File Attributes.
Cascade Overlaps File Manager Directory Windows.
CD or ChDir Changes the Current Directory.
Close Closes Running Applications.
CloseBar Closes WizManager Buttonbar.
Color Changes the Windows Screen Colors.
Copy or CopyQ Copies One or More Files to Another Location.
CustBar Customizes WizManager Buttonbar.
CustLnch Allows Customization of Your Launch Menu.
Date Changes the Date of Your Computer's Clock.
Del, DelQ Deletes One or More Files.
Desktop Changes the Look of Your Desktop.
Dir Displays a Directory Files and Subdirectories.
DiskCopy Copies One Floppy Disk's Content to Another.
DiskFree or DF Displays Disk Free Space.
DiskInfo or DI Displays Disk Information.
DOS Starts a DOS Prompt Session.
Drivers Sets Up Optional Drivers.
Erase or EraseQ Erases One or More Files.
Exit Exits File Manager.
ExitWin Exits Windows.
FDetails Displays All Information on Files and Directories.
FileType Displays a Specified Group of Files.
FName Displays Only File and Directory Names.
Fonts Adds and Removes Fonts.
Format Formats a Floppy Disk.
Help Displays WizManager Help Contents.
Indicate Indicates Expandable Branches in Directory Tree.
Interntl Specifies International Settings.
Keyboard Specifies Keyboard Repeat Rate and Delay.
Lock Locks Windows. (Safety Feature)
MaxFM Enlarges File Manager to its Maximum Size.
Mem Displays Free Memory (RAM) and Resources.
MinApp Reduces All Running Applications to Icons.
MinFM Reduces File Manager to an Icon.
MinWin Reduces All Directory Windows to Icons.
MkDir or MD Creates a Directory.
Mouse Changes Your Mouse Settings.
Move or MoveQ Moves One or More Files to Another Location.
NetCon Connects to a Network Drive.
NetDis or NetDel Disconnects from a Network Drive.
Network Specifies Settings for Your Network Connections.
NewWin Opens a New File Manager Directory Window.
Open Opens Selected Files in File Manager
Password Sets or Changes the Unlock Password.
Path Displays Search Path.
PDetails Displays Partial Information on Files and Directories.
Ports Specifies Serial Ports Communication Settings.
Pref Sets or Changes WizManager Preferences.



Print Prints a File.
PrintDir Prints File Manager Directory Listing.
Printers Sets Up Printers.
PrnTree Prints a Disk Directory Structure.
Reboot Exits Windows and Reboots System.
Refresh Updates the Active File Manager Directory Window.
Ren, RenQ Renames a File or Files.
Rename or RenameQ Renames a File or Files.
RestApp Restores All Applications to their Original Size.
Restart Exits and Restarts Windows.
RestWin Restores All Directory Windows.
RmDir or RD Removes a Directory.
SaveNow Saves Positions and Views of Open Directory Windows.
Search Searches for Files and Directories.
SelDrive Select Disk Drive.
Select Selects Files and Directories in a Directory Window.
ShDir or SD Shares Directory on Network.
SortDate Sorts Directory Window Files by Last Modification Date.
SortName Sorts Directory Window Files and Directories by Name.
SortSize Sorts Directory Window Files by Size.
SortType Sorts Directory Window Files and Directories by Type.
Sound Assigns Sounds to System Events.
StopSh or SS Stops Sharing Directory on Network.
Sys Copies DOS Operating-System Files onto a Floppy Disk.
SysInfo Displays System Information.
Task Displays WizManager Task Menu.
TileH Arranges Directory Windows Horizontally.
TileV Arranges Directory Windows Vertically.
Time Changes the Time of Your Computer's Clock.
Type Displays the Contents of a Text File.
Ver Displays WizManager, DOS and Windows Versions.
Verify Sets or Displays File Write Verify Status.
Vol Displays a Disk Volume Label.

See also
Commands - Categorical Index 



Commands - Categorical Index

Internal Commands
About Displays WizManager About Dialog.
Attrib or AttribQ Changes or Displays File Attributes.
CD or ChDir Changes the Current Directory.
CloseBar Closes WizManager Buttonbar.
Copy or CopyQ Copies One or More Files to Another Location.
CustBar Customizes WizManager Buttonbar.
CustLnch Allows Customization of your Launch Menu.
Del, DelQ Deletes One or More Files.
Dir Displays a Directory Files and Subdirectories.
DiskFree or DF Displays Disk Free Space.
DiskInfo or DI Displays Disk Information.
DOS Starts a DOS Prompt Session.
Erase or EraseQ Erases One or More Files.
Exit Exits File Manager.
ExitWin Exits Windows.
Help Displays WizManager Help Contents.
Lock Locks Windows. (Safety Feature)
Mem Displays Free Memory (RAM) and Resources.
MinApp Reduces All Running Applications to Icons.
MinWin Reduces All Directory Windows to Icons.
MkDir or MD Creates a Directory.
Move or MoveQ Moves One or More Files to Another Location.
Open Opens Selected Files in File Manager
Password Sets or Changes the Unlock Password.
Path Displays Search Path.
Pref Sets or Changes WizManager Preferences.
Print Prints a File.
PrintDir Prints File Manager Directory Listing.
PrnTree Prints a Disk Directory Structure.
Reboot Exits Windows and Reboots System.
Ren, RenQ Renames a File or Files.
Rename or RenameQ Renames a File or Files.
RestApp Restores All Applications to their Original Size.
RestWin Restores All Directory Windows.
Restart Exits and Restarts Windows.
RmDir or RD Removes a Directory.
SaveNow Saves Positions and Views of Open Directory Windows. 
SysInfo Displays System Information.
Task Displays WizManager Task Menu.
Type Displays the Contents of a Text File.
Ver Displays WizManager, DOS and Windows Versions.
Verify Sets or Displays File Write Verify Status.
Vol Displays a Disk Volume Label.

File Manager Related Commands
Associate Associates a File with an Application.
Cascade Overlaps File Manager Directory Windows.
Close Closes Running Applications.
DiskCopy Copies One Floppy Disk's Content to Another.
FDetails Displays All Information on Files and Directories.



FName Displays Only File and Directory Names.
Format Formats a Floppy Disk.
FileType Displays a Specified Group of Files.
Indicate Indicates Expandable Branches in Directory Tree.
MaxFM Enlarges File Manager to its Maximum Size.
MinFM Reduces File Manager to an Icon.
NetCon Connects to or Disconnects from a Network Drive.
NetDis or NetDel Disconnects from a Network Drive.
NewWin Opens a New File Manager Directory Window.
PDetails Displays Partial Information on Files and Directories.
Refresh Updates the Active File Manager Directory Window.
Search Searches for Files and Directories.
SelDrive Selects Disk Drive.
Select Selects Files and Directories in a Directory Window.
ShDir or SD Shares Directory on Network.
SortDate Sorts Directory Window Files by Last Modification Date.
SortName Sorts Directory Window Files and Directories by Name.
SortSize Sorts Directory Window Files by Size.
SortType Sorts Directory Window Files and Directories by Type.
StopSh or SS Stops Sharing Directory on Network.
Sys Copies DOS Operating-System Files onto a Floppy Disk.
TileH Arranges Directory Windows Horizontally.
TileV Arranges Directory Windows Vertically.

Control Panel Related Commands
386 Optimizes Windows for 386 Enhanced Mode.
Color Changes the Windows Screen Colors.
Date Changes the Date of Your Computer's Clock.
Desktop Changes the Look of Your Desktop.
Drivers Sets Up Optional Drivers.
Fonts Adds and Removes Fonts.
Interntl Specifies International Settings.
Keyboard Specifies Keyboard Repeat Rate and Delay.
Mouse Changes Your Mouse Settings.
Network Specifies Settings for Your Network Connections.
Ports Specifies Serial Ports Communication Settings.
Printers Sets Up Printers.
Sound Assigns Sounds to System Events.
Time Changes the Time of Your Computer's Clock.

See also
Commands - Alphabetical Index 



Command Line Box Switches

The execution of any program or opening of a file (from the Command Line Box or from the Launch 
menus) can be customized with the following switches placed at the end of the command:

Switch Action
_____________________________________________________________________________________________________

/+ open maximized.
/- open minimized.
/= open restored (normal size).
/H open and hide.
/@ make the directory where the application (or file) resides the working directory.
/; (semi-colon) make the active File Manager directory the working directory.

See also:
Quick Tips 



Script File

A WizManager script file is a text file which contains a sequence of commands which can be 
executed by WizManager (similar to DOS batch files). 

Script files are used to automate repetitive tasks or simplify the execution of multiple commands. 

WizManager script files must be unformatted ASCII (text) files and must have the .WIZ extension to 
be recognized by WizManager.    To execute a script file, type its path, filename and extension in the 
Command Line Box, or in the Run dialog, or double click its filename in File Manager's directory 
window.    WizManager script files can only be executed if File Manager and WizManager are running.

Because Windows doesn't pass entered parameters along with filenames to associated applications, 
only parameters entered in the Command Line Box will be transferred for execution.

A script can include:

- Any command which can be executed from the Command Line Box (WizManager commands, 
DOS commands, filenames, DOS programs, Windows programs, etc.).

- Replaceable parameters (%1 through %9) which are placeholders for parameters typed at the 
command prompt (see DOS manual) or entered with the ENTERPARAM or ENTERNEWPARAM 
script commands.

- Script Commands .



Script Commands

Script commands:

REM 
Placed at the beginning of a line, it transforms the line into a comment. The line is ignored by 
WizManager.

ENTERPARAM [Text in dialog] 
Displays a dialog box which allows the user to optionally enter new parameters which then become 
usable variables for the replaceable parameters %0 through %9. 
If no parameter is entered after ENTERPARAM, 'Enter parameters:' is displayed in the dialog. 
Because Windows doesn't pass parameters to associated applications, the ENTERPARAM command 
is particularly useful when a script is most often used from a File/Run command or is started by double 
clicking its name in the File Manager directory window. ENTERPARAM allows the user to still enter 
parameters in the latter cases. Parameters entered after a script filename are recognized if entered 
from the Command Line Box.
ENTERPARAM can be used multiple times in a script to prompt the user to enter new parameters for 
the following lines in the script. The previous parameters (if any) are displayed as default in the dialog. 

ENTERNEWPARAM [Text in dialog]
Is equivalent to ENTERPARAM except that previous parameters are not displayed as default.

PAUSE [text to display] 
Opens a dialog box which displays the text entered after PAUSE. If no text is entered then 'Continue?' 
is displayed as default. Ok and Cancel buttons are displayed. Selecting Ok (default button) continues 
the script, selecting Cancel aborts the script.

PAUSE![text to display] 
Is equivalent to PAUSE except that an exclamation point icon is displayed.

PAUSE? [text to display] 
Is equivalent to PAUSE except that a question mark icon is displayed.

ECHO <text to display> 
Is similar to PAUSE except that only an Ok button is displayed. ECHO without a text to display 
parameter is ignored. 

ECHO! <text to display> 
Is equivalent to ECHO except that an exclamation point icon is displayed.

ECHO? <text to display> 
Is equivalent to ECHO except that a question mark icon is displayed.

See also:
Script Example 



Script Example

Simple (theoretical) script example:      EXAMPLE.WIZ

        REM This is a script example for WizManager
        ECHO Please insert a diskette in drive A:
        DISKFREE a:
        PAUSE? Do you want to proceed with the transfer?
        ENTERPARAM Enter the filename of the file(s) to transfer (use wildcards if necessary):
        MOVE %1 a: /N
        ECHO! File(s) transferred.
        PAUSE? Do you want to delete .BAK files?
        ENTERNEWPARAM Enter the path where the .BAK files are located:
        DELETE %1\*.bak /P
        ECHO! The .BAK files are deleted!
        PAUSE? Start Word for Windows?
        c:\winword\winword.exe

See also:
Script File    
Script Commands 



WizManager Menu Commands

WizManager menu commands:

Launch 

View Files... 
Open Files...        

Zip Files... 
UnZip File...
Open Zip File... 

Find Files... 
Find Duplicates... 
Synchronize Directories... 
Directories Size Browser... 
Set Files Date/Time... 

DOS Prompt 
Lock... 
Print Directory... 
Print Tree... 
Printer Setup... 
Info 
Control Panel 
Exit 

Customize Buttonbar... 
Customize Launchbar... 
Customize Launch Menus... 
Preferences...    

About WizManager... 
Help 

See also
Command added to the Options menu 
Commands added to the Window menu 



Command Added to the Options Menu

Command added to File Manager's Options menu:

Save Settings Now 

See also
WizManager menu commands 
Commands added to the Window menu 



Commands Added to the Window Menu 

Commands added to File Manager's Window menu:

New + Cascade 
New + Tile Horizontally 
New + Tile Vertically 
Tile Horizontally    
Tile Vertically 
Minimize 
Restore 

See also
WizManager menu commands 
Command added to the Options menu 



Preferences

Select the Preferences command from the WizManager menu to display the Preferences dialog. 
Through the Preferences dialog you can customize WizManager and specify how you want to work with
the various components of WizManager.

Preferences is divided in several categories. Select a category from the Category list (left side of the 
Preferences dialog) and the category's options will be displayed in the Preferences dialog. Then make 
the appropriate modifications (if necessary) and save your modifications by clicking the Ok button.    
Select the Cancel button if you wish WizManager to ignore your modifications.

Preferences Categories:
General Setup

System Setup 
Popup Menu
Command Confirmations
File List in Dialogs 
Zip/UnZip 



Customize Buttonbar

Select Customize | Buttonbar from the WizManager menu to access the Customize Buttonbar dialog.

The Customize Buttonbar dialog allows you to reorganize the Buttonbar's button order, add or remove 
buttons, set the number of buttons displayed, and specify the number of buttons scrolled per scroll 
increment.    You can also specify the respective position of the Buttonbar in File Manager with respect 
to the Launchbar.

The Customize Buttonbar dialog presents two buttonbars: The top bar is a replica of the actual 
Buttonbar and the bottom bar (Additional Buttons bar) is a set of additional buttons. This latter bar is 
used to add or remove buttons from the Buttonbar. 

To reorganize your Buttonbar:

To optimize your work with the Buttonbar, move the most often used buttons to the beginning of the 
Buttonbar and the least often used to the end. To move a button, simply drag and drop it to its new 
location using the mouse. To add a button to the Buttonbar, drag it from the 'Additional Buttons' bar to 
the Buttonbar. To remove a button from the Buttonbar, drag it from the Buttonbar to the 'Additional 
Buttons' bar.

If you wish to reset the Buttonbar button order and contents back to its default, select the Reset button.

To modify the number of buttons displayed:

If you are not using File Manager in its full width, it is necessary to reduce the number of buttons 
displayed in the Buttonbar in order to have access to all the buttons when the Buttonbar is scrolled. 
Select the number of buttons which should be displayed in the Buttonbar from the number of buttons 
displayed per button page list.

To modify the number of buttons scrolled:

When the Buttonbar is scrolled, WizManager refreshes as many buttons as are displayed in the 
Buttonbar (button page). However, it is possible to reduce the number of buttons scrolled each time by 
selecting the desired number from the scroll increment list.

To position the Buttonbar:

With the Display Buttonbar below Launchbar check box, you can specify whether the Buttonbar or the 
Launchbar should be the topmost bar displayed. Check the box if you wish to have the Launchbar as 
the first bar and uncheck it if you wish to have the Buttonbar as the first bar in File Manager.



Command Line Box Editing

The Command Line Box accepts and executes commands entered with the keyboard or pasted from 
the clipboard. You can use the following keys to edit commands. To execute a command, press 
ENTER.

Press To
_______________________________________________________________________________________

Left Arrow Move the cursor back one character.
Right Arrow Move the cursor forward one character.
Ctrl+Left Arrow Move the cursor to the previous word.
Ctrl+Right Arrow Move the cursor to the next word.
Home Move the cursor to the start of the line.
End Move the cursor to the end of the line.
Delete Delete the character to the right of the cursor.
BackSpace Delete the character to the left of the cursor.
Esc Clear the Command Line Box.

See also
Command Line Box History    
Shortcut Keys 



Command Line Box History

The Command Line Box keeps a list of your commands as you type them. You can use the following 
keys to view previous commands. To carry out a command again after it is displayed, press ENTER.

Press To
_______________________________________________________________________________________________

Up Arrow Display the previous command in the list.
Down Arrow Display the next command in the list.
Alt+Down Arrow or F4 Display the list of previously entered commands.
Alt+Up Arrow or F4 Close the list of previously entered commands.
Page Up Display the newest command in the list.
Page Down Display the oldest command in the list.

The last 15 commands entered in the Command Line Box are automatically saved and are available in 
the Command Line Box history the next time File Manager and WizManager are started.

See also
Command Line Box Editing      
Shortcut Keys 



Shortcut Keys

WizManager shortcut keys:

Press To
___________________________________________________________________________________________

Alt+BackSpace Activate the Command Line Box.
Alt+Enter Return to the File Manager directory window.
Alt+1 Display/Hide the Buttonbar.
Alt+2 Display/Hide the Launchbar.
Alt+3 Display/Hide the Command Line Box.
Alt+4 View Files.
Alt+5 Open Files.
Alt+6 Find Files.
Alt+7 Synchronize Directories.
Alt+8 New Window.
Alt+9 View | File Name
Alt+0 View | All Files Details
Alt+, Zip Files.
Alt+; UnZip File.
Alt+! Lock.
Alt+. DOS Prompt.
Alt+: Format Disk.

WizManager mouse shortcuts:

Press To
___________________________________________________________________________________________

Left Button on a buttonbar Button Activate the button's function.
Shift+Left Button on a buttonbar Button Display the button's info window.
Right Button on buttonbar Scroll the Buttonbar.
Right Button on File Manager Display WizManager's popup menu.

See also
Command Line Box Editing      
Command Line Box History 



License Agreement

Your use of Mijenix Corporation's WizManager software program indicates your 
understanding and acceptance of    the following terms and conditions. If you do
not understand or do not agree to the terms of this agreement, you must cease 
using this product immediately.

This License Agreement applies to the registered version of WizManager.    The use of the 
shareware version of WizManager is ruled by the shareware license contained in the 
LICENSE.DOC file included with the WizManager shareware files.

Mijenix Corporation License Agreement
This is a legal agreement between you (either an individual or an entity) and Mijenix Corporation.    By
opening the sealed software packet or using Mijenix Corporation's WizManager software program, 
you agree to be bound by the terms of this agreement.    If you do not understand or do not agree to 
the terms of this agreement, you must cease using this product immediately.

Mijenix Corporation Software License
1.    GRANT OF LICENSE.    This License Agreement permits you to use one copy of the enclosed 
Mijenix Corporation software program (the "SOFTWARE") on a single computer.    The SOFTWARE is
in "use" on a computer when it is loaded into temporary memory (i.e. RAM) or installed into 
permanent memory (e.g. hard disk, CD-ROM, or other storage device) of that computer.    However, 
installation on a network server for the sole purpose of internal distribution shall not constitute "use" 
for which a separate license is required, provided you have a separate license for each computer to 
which the SOFTWARE is distributed.

2.    COPYRIGHT.    The SOFTWARE is owned by Mijenix Corporation or its suppliers and is protected
by United States copyright laws and international treaty provisions.    Therefore, you must treat the 
SOFTWARE like any other copyrighted material (e.g. a book or musical recording) except that you 
may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) 
transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or 
archival purposes.    You may not copy the written materials accompanying the SOFTWARE.

3.    OTHER RESTRICTIONS.    You may not rent or lease the SOFTWARE, but you may transfer the 
SOFTWARE and accompanying written materials on a permanent basis provided you retain no 
copies and the recipient agrees to the terms of this Agreement.    You may not reverse engineer, 
decompile, or disassemble the SOFTWARE.    If the Software is an update or has been updated, any 
transfer must include the most recent update and all prior versions.

4.    DUAL MEDIA SOFTWARE.    If the SOFTWARE package contains both 3.5" and 5.25 disks, then 
you may use only the disks appropriate for your single-user computer.    You may not use the other 
disks on another computer or loan, rent, lease, or transfer them to another user except as part of the 
permanent transfer (as provided above) of all SOFTWARE and written materials.

Limited Warranty
LIMITED WARRANTY.    This program is provided "as is" without any warranty of any kind, 
either expressed or implied, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose.    The entire risk as to the quality and 
performance of the SOFTWARE is with you, the licensee.    Should the SOFTWARE prove 
defective, you assume the risk and liability for the entire cost of all necessary repair, service, 
or correction.    Some states/jurisdictions do not allow the exclusion of implied warranties, so 
the above exclusion may not apply to you.    This warranty gives you specific legal rights, and 
you may have other rights which vary from state/jurisdiction to state/jurisdiction.    



Mijenix Corporation does not warranty the functions contained in the SOFTWARE will meet your 
requirements, or that the operation of the SOFTWARE will be error-free or uninterrupted.    Mijenix 
Corporation does warrant that the disk(s) on which the program is furnished shall be free from defects
in materials and workmanship for a period of ninety (90) days from the date of purchase, so long as 
proof of purchase is provided.

CUSTOMER REMEDIES.    Mijenix Corporation's and its suppliers' entire liability and your exclusive 
remedy shall be, at Mijenix Corporation's option, either (a) return of the price paid, or (b) repair or 
replacement of the SOFTWARE that does not meet Mijenix Corporation's Limited Warranty and which
is returned to Mijenix Corporation with proof of purchase.    This Limited Warranty is void if failure of 
the SOFTWARE has resulted from accident, abuse, or misapplication.    Any replacement 
SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) days, 
whichever is longer.    Neither these remedies nor any product support services are available 
outside the United States without proof of purchase from an authorized non-U.S. source.

NO OTHER WARRANTIES.    To the maximum extent permitted by applicable law, Mijenix 
Corporation and its suppliers disclaim all other warranties, either express or implied, 
including, but not limited to, implied warranties of merchantability and fitness for a particular 
purpose, with regard to the SOFTWARE, the accompanying written materials, and any 
accompanying hardware.    This limited warranty gives you specific legal rights.    You may 
have others which vary from state/jurisdiction to state/jurisdiction.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES.    To the maximum extent permitted by 
applicable law, in no event shall Mijenix Corporation or its suppliers be liable for any damages 
whatsoever (including, without limitation, damages for loss of business profits, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use 
or inability to use this Mijenix Corporation product, even if Mijenix Corporation has been 
advised of the possibility of such damages or for any claim by any other party.    Because 
some states/jurisdictions do not allow the exclusion or limitation of liability for consequential 
or incidental damages, the above limitation may not apply to you.

U.S. GOVERNMENT RESTRICTED RIGHTS
The SOFTWARE and documentation are subject to export controls under the United States Export 
Administration Act, as amended, which Act prohibits exports of certain commodities and technical 
data, including software, to specified countries.    You hereby certify that neither the SOFTWARE nor 
the documentation will be transmitted or forwarded outside of your country.    
    

If you acquired this product in the United States, this Agreement is governed by the laws of the State of 
Wisconsin.

Should you have any questions concerning this Agreement, or if you desire to contact Mijenix 
Corporation for any reason, you may write to Mijenix Corporation, 6666 Odana Road, Ste 326, 
Madison, WI    53719.

BY OPENING THE SEALED SOFTWARE PACKET OR USING MIJENIX CORPORATION'S 
WIZMANAGER SOFTWARE PROGRAM, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS 
AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS.    YOU FURTHER 
AGREE THAT IT IS THE FULL AND COMPLETE AGREEMENT BETWEEN US, SUPERSEDING ANY
WRITTEN OR VERBAL PRIOR AGREEMENT OF ANY KIND.



Shareware Concept

What is shareware?

Contrary to popular belief, shareware is not a type of software, but a method of marketing software. It
is a marketing plan based entirely on trust between the owner of the shareware program and you, 
the user. Shareware is copyrighted software which you can try before buying. This is a great concept 
which allows you to use the program during a limited time, (21 days for Mijenix Corporation's 
WizManager), and evaluate its features on your terms. In many cases, shareware programs are as 
good, or even better, than software available only through normal retail channels. Because 
shareware is marketed at reduced cost, buying shareware programs allows you to save money and 
helps shareware authors to continue providing innovative, useful and affordable programs. 

Registering shareware?

Shareware authors release programs with an element of trust, expecting payment if a program is 
used past the evaluation period. When users register shareware programs they find useful, they 
receive in return the right to use the program. 

When you register and buy Mijenix Corporation's WizManager you receive the full-featured 
registered and enhanced version of WizManager (latest version). In addition, you receive 
additional utilities, an in-depth user's manual, new release information, special upgrade 
offers, and 90 days of free technical support.



386 

Control Panel

Purpose: Opens the Control Panel 386 Enhanced dialog which allows you to optimize 
Windows for 386 Enhanced Mode.

Syntax: 386  [/?]

Switch: /?    Displays this command help topic.

Usage: By using the 386 Enhanced option, you can specify how Windows controls 
simultaneous requests from applications for devices, such as printers and modems. 
You can also determine how Windows should allocate time slices and computer 
resources when both Windows applications and non-Windows applications are 
running at the same time. Settings for swap files, and the use of 32-bit disk access 
can also be specified.

NOTE: This option is available only on systems which can run Windows in 386 
Enhanced Mode.



About

Internal

Purpose: Displays WizManager About dialog.

Syntax: ABOUT    [/?]

Switch: /? Displays this command help topic.

Usage: WizManager About dialog displays information about WizManager    version number, 
Windows running mode, and memory usage. It also lists the different channels 
through which you can contact Mijenix (Tel, fax, CompuServe, EMail, etc.). 



Associate

File Manager

Purpose: Opens File Manager Associate dialog which allows you to associate a file with an 
application so that the application starts when you open the file (or any other file that
has the same extension).

Syntax: ASSOCIATE  [/?]

Switch: /?    Displays this command help topic.

Usage: When you associate a file with an application, you can open the file and start the 
application at the same time. If a file is associated with an application, there is a 
document-file icon (lined document icon) next to the filename in the File Manager 
directory window.

A file having an association can be launched from WizManager's Command Line 
Box without specifying the application. The file's extension is used to recognize its 
association to an application. 



Attrib,  AttribQ

Internal

Purpose: Changes or displays file(s) or subdirectory attributes.

Syntax: ATTRIB [+a|-a] [+s|-s] [+h|-h] [+r|-r] [drive:][path] filename [/P /N /?]
or
ATTRIBQ [+a|-a] [+s|-s] [+h|-h] [+r|-r] [drive:][path] filename [/N /?]

Parameters: [drive:][path] filename Specifies the location and name of the file or set of files 
whose attribute(s) will be changed or displayed. 

Switches: +a Sets the archive file attribute.
-a Clears the archive file attribute.
+s Sets the file as a system file.
-s Clears the system file attribute.
+h Sets the file as a hidden file.
-h Clears the hidden file attribute.
+r Sets the read-only file attribute.
-r Clears the read-only file attribute.
/P Prompts to confirm each file before its attributes are changed.
/N No confirmation.
/? Displays this command help topic.

Usage: The ATTRIB command lets you set [+] or clear [-] any attribute(s) for any file, group 
of files, or subdirectory. You can view file attributes by entering ATTRIB without 
specifying new attributes (i.e. without the switches part of the syntax). Wildcards (? 
and *) can be used with the filename parameter to display or change the attributes 
for a group of files. 

Every file and subdirectory has 4 attributes that can be set or cleared: Archive, 
System, Hidden, and Read-Only. The Archive attribute is set every time a file is 
updated or changed. Backup utilities often use this attribute to find files that have 
changed since the last general backup.

By default, when wildcards are used, files with the System or Hidden attribute set 
are not included in the execution of the Copy, Move, Delete, Rename or Dir 
command. Nevertheless, these commands have specific switches to include the 
latter files. You can also customize the file inclusion in WizManager Preferences. 

Unless you specify otherwise in the Preferences, WizManager will display a 
confirmation dialog if you try to delete or rename a file with either the System, 
Hidden or Read-Only attribute set.

You can press the ESC key (Escape key) at any time to interrupt ATTRIB.

The ATTRIBQ command has the same format as the ATTRIB command. ATTRIBQ 
automatically asks you to confirm the attribute change of each file before the 
command is actually executed. ATTRIBQ is most useful when used with the 
wildcards characters ? and * to change attributes of a group of files. ATTRIBQ is 
equivalent to ATTRIB with /P switch.



Examples: To display the file attributes in the subdirectory DOCUMENT, 
type:    attrib \document
To set the Archive attribute to all the files with the extension .DRW,
type:    attrib +a *.drw
To clear the Read-Only attribute of the file RESULTS.TXT, 
type:    attrib -r results.txt



Cascade

File Manager

Purpose: Arranges File Manager directory windows so that they overlap.

Syntax: CASCADE    [/?]

Switch: /? Displays this command help topic.

Usage: This command arranges the File Manager directory windows so that they overlap, 
like cards. The title bar of each window remains visible, making it easy for you to 
select any window.    



CD or ChDir

Internal

Purpose: Changes the current directory.

Syntax: CHDIR [drive:][dirpath]  [/?]
or
CD [drive:][dirpath]  [/?]

Parameters: [drive:] Specifies the drive name.
[dirpath] Specifies the directory path to change to.

Switch: /? Displays this command help topic.

Usage: The Change Directory command (CHDIR or its short form CD) lets you navigate 
(move) through the directory structure of your disk and change the current working 
directory. If you enter CD and a directory name, the named directory becomes the 
new current directory. 

Examples: To move from the root directory C:\ to the subdirectory C:\CLIENTS\SMITH, 
type:    cd \clients\smith
To move from C:\ to the drive and subdirectory D:\PROJECT, 
type:    cd d:\project
To move to the root directory, 
type:    cd \
To move to the parent directory, 
type:    cd ..
To move to the sibling directory JONES, 
type:    cd ..\jones



CloseBar

Internal

Purpose: Closes WizManager Buttonbar.

Syntax: CLOSEBAR    [/?]

Switch: /? Displays this command help topic.

Usage: The command CLOSEBAR is used to close the Buttonbar. When the Buttonbar is 
turned off, the screen space occupied by the Buttonbar is freed for File Manager 
directory windows. This may be useful when a maximum amount of information 
should be displayed within the File Manager window.

To have the Buttonbar displayed again, select the Buttonbar command from the 
WizManager menu. 



Close

Internal

Purpose: Closes running applications.

Syntax: CLOSE    [/?]

Switch: /? Displays this command help topic.

Usage: The command CLOSE lets you close any application currently running in Windows. 
The command displays the name of each application and asks you to confirm the 
termination. This allows you to decide whether or not to close any application. 

Note:    You have to quit any DOS application before you can close it. 



Color 

Control Panel

Purpose: Opens the Control Panel Color dialog which allows you to change the Windows 
screen colors.

Syntax: COLOR    [/?]

Switch: /? Displays help information for the command.

Usage: By using the Control Panel Color option, you can change the colors of most of the 
Windows desktop elements.



Copy,  CopyQ

Internal

Purpose: Copies one or more files to another location. A file can be copied to a disk, directory, 
file, or    physical hardware device (such as a printer or serial port).

Syntax: COPY source [destination] [/A /H /S /P /N /V /?]
or
COPYQ source [destination] [/A /H /S /N /V /?]

Parameters: source Specifies the path and name of a file or set of files or a directory or a 
device to copy from.

destination Specifies the path and name of a file or a directory or a device to copy
to.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files.
/P Prompts to confirm each file before it is copied.
/N No confirmation prompt.
/V Verifies that files are written correctly. Destination file content and source file

content are compared to assess the accuracy of the copying process.
/? Displays this command help topic.

Usage: The most common use of COPY is to make a copy of one or more files to another 
location either on the same disk or another disk. However, COPY can also be used 
to combine files together into one file, to view files, and to send files to a printer or 
communication port.

If the destination specification is omitted, a copy is created    in the current directory 
on the current drive, with the same name, creation date, and creation time as the 
original file. It is not possible to copy a file onto itself. Wildcards (? and *) can be 
used in the source and the destination file specifications.

A confirmation dialog is displayed if the destination file specification matches one 
already on the destination drive.

If the destination specification    is a drive, directory, or device name then the source 
files are copied individually to the new location.    If the destination specification is a 
file name, the first source file is copied to the destination, and any additional source 
files are then appended to the new destination file.

DOS file naming conventions have to be followed when renaming files during a copy.

You can press the ESC key (Escape key) at any time to interrupt COPY.

The COPYQ command has the same format as the COPY command. COPYQ 
automatically displays the name of the file to copy and asks you for confirmation 
before completing the copy. COPYQ is most useful when used with the wildcard 
characters ? and * to copy a group of files. COPYQ is equivalent to COPY with /P 
switch.



Examples: To copy (duplicate) the file REPORT.TXT in the same directory    and name the copy 
REPORT.BAK, 
type :    copy report.txt report.bak
To copy all the files in the current directory of    the floppy drive a: to the current 
working directory, 
type:    copy a:*.*
To copy all the files in the subdirectory \PROJECT to the subdirectory \ARCHIVE, 
type:    copy \project \archive 

To copy (append) all the files with the .DOC extension in the current directory into 
the single file REPORT.TXT, 
type:    copy *.doc report.txt
To copy (display) the file SHOWME.TXT to the screen, 
type:    copy showme.txt con



CustBar

Internal

Purpose: Opens WizManager Customize Buttonbar dialog which allows you to set the button 
order of the Buttonbar.

Syntax: CUSTBAR    [/?]

Switch: /? Displays this command help topic.

Usage: The default order of the buttons in the Buttonbar may not fit your actual needs. If you
experience frequent scrolling of the Buttonbar you should reorganize and customize 
your Buttonbar. The Buttonbar customization is simple: click (select) the button in the
listbox whose position you wish to change. Thef use Move Up or Move Down to 
move the activated button further to the front or to the back of the Buttonbar. Once 
satisfied with the modifications, select OK to save your configuration and reconstruct
the Buttonbar according to your preferences.

If you wish to reset the button order to the original default order, select the Reset 
button.



CustLnch

Internal

Purpose: Opens WizManager Customize Launch Menus dialog which allows you to setup the 
launch menu. 

Syntax: CUSTLNCH    [/?]

Switch: /? Displays this command help topic.

Usage: WizManager Launch offers you a convenient way to launch applications, open files 
or execute specific commands quickly.    You can set up to 20 customized launch 
submenus and you can edit them at any time making it easy to redefine your Launch
submenus whenever your needs change. The CUSTLNCH command opens the 
Customized Launch dialog which lets you insert, modify or delete any launch 
submenu.



Date 

Control Panel

Purpose: Opens the Control Panel Date/Time dialog which allows you to change the date of 
your computer's clock.

Syntax: DATE    [/?]

Switch: /? Displays this command help topic.

Usage: By using the Date/Time Control Panel option, you can change the date and time of 
your system's clock. The format of the date and time is set with the Short Date and 
Time Format options in the International settings dialog box. 

It is important that your system's date and time are always accurate. Many 
applications, including File Manager, Clock$ and Calendar, use your system's date 
and time to record important information. 



Del,  DelQ

Internal

Purpose: Deletes one file, a group of files, or an entire subdirectory.

Syntax: DEL [drive:][path] filename [/A /H /P /N /S /?]
or
DELQ [drive:][path] filename [/A /H /S /?]

Parameters: [drive:][path] filename Specifies the location and name of the file or set of files to 
delete.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/P Prompts to confirm each file before it is deleted.
/N No confirmation prompt.
/S Includes system files. 
/? Displays this command help topic.

Usage: The deletion command (DEL and ERASE are synonyms) removes the specified file 
or files from the directory. CAUTION: the deleted files may be impossible to recover 
without specialized utilities.

Wildcards (? and *) can be used to delete more than one file at a time. To delete all 
the files contained in a directory, simply enter the directory path and name as 
parameter. 

You can press the ESC key (Escape key) at any time to interrupt DEL.

The DELQ command has the same format as the DEL command. DELQ 
automatically displays the name of the file to delete and queries you for confirmation 
before completing the deletion. DELQ is most useful when used with the wildcard 
characters ? and * to delete a group of files. DELQ is equivalent to DEL with /P 
switch.

Examples: To delete the file TEST.TXT in the current directory, 
type:    del test.txt
To delete all the files in the directory \PROJECT, 
type:    del \project  or  del \project\*.*



Desktop 

Control Panel

Purpose: Opens the Control Panel Desktop dialog which allows you to change the look of your
desktop.

Syntax: DESKTOP    [/?]

Switch: /? Displays this command help topic.

Usage: By using the Desktop option, you can change the look of your desktop. For example,
you can select patterns or images to decorate the desktop background, specify a 
screen saver, set the cursor blink rate, the icon spacing, the grid size, and the border
width. 



Dir

Internal

Purpose: Displays the list of files and subdirectories in a directory.

Syntax: DIR [drive:][path][filename] [/A /H /S /?]

Parameters: [drive:][path] Specifies the drive and directory to be listed.
filename Specifies a particular file or group of files to be listed.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files. 
/? Displays this command help topic.

Usage: DIR without parameters displays all files, other than system or hidden files, and all 
subdirectories in the current directory. The appropriate switch(es) can be entered to 
include system files and/or hidden files in the listing. 

The existence of a particular file or group of    files can be verified using DIR and 
entering the desired request as the filename. The file selection can be specific or 
more general using wildcards (? and *). If the file or group of files exists, detailed file 
information (name, size, creation time and attributes) is listed. An appropriate error 
message is displayed if the file or group of files is not found.

Examples: To display all the files and subdirectories in the current directory, 
type:    dir
To look for the existence of    the specific file LIST.TXT in the current directory, 
type:    dir list.txt
To display all the files with the .DOC extension in the \LETTERS directory, 
type:    dir \letters\*.doc
To display all the files in the subdirectory \PROJECT, 
type:    dir \project  or  dir \project\*.*



DiskCopy

File Manager

Purpose: Opens File Manager Copy Disk dialog which allows you to copy the contents of a 
floppy disk onto another floppy disk.

Syntax: DISKCOPY    [/?]

Switch: /? Displays this command help topic.

Usage: Use this command, for example, to make a backup copy of a floppy disk. If you have
more than one floppy disk drive, the Copy Disk dialog box appears asking you to 
specify the source and destination drives.    

NOTE: Before you copy a floppy disk, a confirmation message appears. If you don't 
want to receive confirmation messages, you can turn them off by using the 
Confirmation command on the File Manager Options menu. 



DiskFree or  DF

Internal

Purpose: Displays a disk's free space and size in kBytes and its used space in %.

Syntax: DISKFREE [drive:]  [/?]
or
DF [drive:]  [/?]

Parameter: [drive:] Specifies the drive whose space information should be displayed.

Switch: /? Displays this command help topic.

Usage: The DISKFREE command is a fast way to get information about the amount of free 
space left on a drive. For example, you can use DISKFREE to check the free space 
of the destination drive, like a floppy disk,    before starting a COPY or MOVE file 
operation.

DISKFREE without parameter displays free space information of the current drive. 



DiskInfo or DI

Internal

Purpose: Displays Disk Information.

Syntax: DISKINFO [drive:]  [/?]
or
DI [drive:]  [/?]

Parameter: [drive:] Specifies the drive whose information should be displayed.

Switch: /? Displays this command help topic.

Usage: DISKINFO scans a drive and retrieves varied information about disk usage and files 
statistics. DISKINFO displays:

Disk size
Space used by files
Free space left
Percentage of disk used
Average file size
Total number of files
Total number of directories
Smallest file size and path
Largest file size and path
Largest directory structure and path

DISKINFO without parameter displays disk information of the current drive. 

NOTE: DISKINFO and File Manager display inaccurate file space usage of drives 
which are user space restricted network drives (allocated space). The used space 
displayed is the unavailable drive space added to the actual file space. The average 
file size is therefore inaccurate.



DOS

Internal

Purpose: Starts a new DOS prompt (command line) session. 

Syntax: DOS    [/?]

Switch: /? Displays this command help topic.

Usage: This command executes the program named COMMAND.COM through a 
configuration file named DOSPRMPT.PIF. The latter file is automatically installed in 
your Windows directory when Windows is installed. DOSPRMPT.PIF controls 
several facets of the way COMMAND.COM is launched from this command. You can
modify (or recreate if necessary) the file using the Windows application 
PIFEDIT.EXE. Refer to the "PIF Editor" chapter of your Windows User's Guide for 
detailed information on how to customize a PIF file.

A different PIF file can be used instead of DOSPRMT.PIF. You can set your 
preferences by selecting the WizManager Preferences menu command or by typing 
PREF    in WizManager's Command Line Box.



Drivers 

Control Panel

Purpose: Opens the Control Panel Drivers dialog which allows you to setup Windows optional 
drivers.

Syntax: DRIVERS    [/?]

Switch: /? Displays this command help topic.

Usage: Use the Control Panel Drivers option to install, remove, and configure drivers that 
control additional devices, such as sound cards, video players, and pen tablets that 
you add to your system.    



Erase,  EraseQ

Internal

Purpose: Erases one file, a group of files, or an entire subdirectory.

Syntax: ERASE [drive:][path] filename [/A /H /S /P /N /?]
or
ERASEQ [drive:][path] filename [/A /H /S /N /?]

Parameters: [drive:][path] filename Specifies the location and name of the file or set of files to 
erase.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files.
/P Prompts to confirm each file before it is erased.
/N No confirmation prompt.
/? Displays this command help topic.

Usage: The deletion command (ERASE and DEL are synonyms) removes the specified file 
or files from the directory. CAUTION: the erased files may be impossible to recover 
without specialized utilities.

Wildcards (? and *) can be used to erase more than one file at a time. To erase all 
the files contained in a directory, simply enter the directory path and name as 
parameter. 

You can press the ESC key (Escape key) at any time to interrupt ERASE.

The ERASEQ command has the same format as the ERASE command. ERASEQ 
automatically displays the name of the file to erase and asks you for confirmation 
before completing the deletion. ERASEQ is most useful when used with the wildcard
characters ? and * to erase a group of files. ERASEQ is equivalent to ERASE with /P
switch.

Examples: To erase the file TEST.TXT in the current directory, 
type:    erase test.txt
To erase all the files in the directory \PROJECT, 
type:    erase \project  or  erase \project\*.*



Exit

Internal

Purpose: Closes and exits File Manager.

Syntax: EXIT      [/?]

Switch: /? Displays this command help topic.

Usage: This command gives you a fast way to end the current File Manager session. It is 
equivalent to selecting the Exit command from the File menu, or typing the ALT+F4 
key combination.



ExitWin

Internal

Purpose: Closes and ends any application running in Windows and exits Windows.

Syntax: EXITWIN    [/?]

Switch: /? Displays this command help topic.

Usage: The EXITWIN command lets you quickly close and terminate Windows. EXITWIN 
executes an orderly shutdown sequence of windows. A confirmation dialog is 
displayed before proceeding with the closing. This can be changed in the 
Preferences dialog.

During the process, any running application with unsaved changes will ask for 
confirmation before closing. If all applications agree to quit, the Windows session is 
terminated and control returns to DOS.



FDetails

File Manager

Purpose: This command calls the File Manager View All File Details command and displays all
available information about files and directories in the active File Manager directory 
window.    

Syntax: FDETAILS    [/?]

Switch: /? Displays this command help topic.

Usage: This File Manager command displays detailed information of each file and directory 
in the active File Manager directory window such as name, size, last modification 
date and time, and attributes. 

NOTE:    The View commands (Name, All File Details, and Partial Details 
commands) affect only the contents list in a File Manager directory window. If the 
directory window is displaying only the directory tree, the window is not affected by 
these commands. 



FileType

File Manager

Purpose: Opens File Manager View By File Type dialog which allows you to select particular 
groups of files. 

Syntax: FILETYPE    [/?]

Switch: /? Displays this command help topic.

Usage: Use this command to display a group of files in the current File Manager directory 
window, such as files with a certain extension or of a particular file type. The 
FILETYPE command affects the contents list in the active File Manager directory 
window only.    



FName

File Manager

Purpose: This command calls the File Manager View Name command and displays only the 
names of files and directories in the active File Manager directory window. 

Syntax: FNAME    [/?]

Switch: /? Displays this command help topic.

Usage: This File Manager command restricts the information displayed to the names and 
extensions only of the files and directories, enabling the active File Manager 
directory window to display more files and directories in its window. 

NOTE:    The View commands (Name, All File Details, and Partial Details 
commands) affect only the contents list in a File Manager directory window. If the 
directory window is displaying only the directory tree, the window is not affected by 
these commands. 



Fonts 

Control Panel

Purpose: Opens the Control Panel Fonts dialog which allows you to add and remove fonts and
set TrueType options.

Syntax: FONTS    [/?]

Switch: /? Displays this command help topic.

Usage: Use the Control Panel Fonts option to add fonts to and remove fonts from your 
Windows applications, and to set TrueType options. You can also use this option to 
display a sample of a font.

NOTE: Some printer fonts must be set up by using a font-installation program 
provided by the font manufacturer. 



Format

File Manager

Purpose: Opens File Manager Format Disk dialog which allows you to format a floppy disk.

Syntax: FORMAT    [/?]

Switch: /? Displays this command help topic.

Usage: Before you can use a disk, you must format it. Formatting prepares the disk for use 
with your computer and deletes any previous information stored on it. 

NOTE: Before you format a floppy disk, a confirmation message appears. If you 
don't want to receive confirmation messages, you can turn them off by using the 
Confirmation command on the File Manager Options menu. 



Help

Internal

Purpose: Displays WizManager Help contents.

Syntax: HELP

Switch: /? Displays this command help topic.

Usage: The HELP command opens WizManager help file and displays its help contents 
(index). From there it is possible to access any information either through the logic of
the different help items (jumps) or through the Search command. 



Indicate

File Manager

Purpose: Opens File Manager Indicate Expandable Branches dialog which allows you to 
select whether a directory, which has a subdirectory structure, is marked or not.

Syntax: INDICATE    [/?]

Switch: /? Displays this command help topic.

Usage: This command marks a directory icon with a plus sign (+) if the directory has 
subdirectories. When you expand a directory, the plus sign changes to a minus sign 
(-). To turn off this feature, type the INDICATE command again or choose the 
Indicate Expandable Branches menu command. 

NOTE: If you use the Indicate Expandable Branches command to mark expandable 
directories, File Manager takes longer to create the directory tree. This can be a 
significant slow-down.    



Interntl 

Control Panel

Purpose: Opens the Control Panel International dialog which allows you to specify 
international settings.

Syntax: INTERNTL    [/?]

Switch: /? Displays this command help topic.

Usage: By using the International option, you can specify international settings such as 
country and language, number and currency formats, date and time formats, and 
keyboard layout. Certain applications refer to these settings to set their default 
method of displaying or sorting information.

NOTE: This Control Panel option does not change the language of the Windows 
product itself, only the way applications sort and manage information using these 
formats.



Keyboard 

Control Panel 

Purpose: Opens the Control Panel Keyboard dialog which allows you to specify keyboard 
repeat rate and delay.

Syntax: KEYBOARD    [/?]

Switch: /? Displays this command help topic.

Usage: By using the Control Panel Keyboard option, you can specify how long your 
computer waits after you press and hold down a key to repeat that key, and how fast 
the key repeats. 

NOTE: If you want to change the keyboard layout, use the Control Panel 
International option.



Lock

Internal

Purpose: Minimizes all running applications and locks Windows until you enter your password 
in the displayed Unlock dialog.

Syntax: LOCK    [/?]

Switch: /? Displays this command help topic.

Usage: The LOCK command lets you completely lock your system and restore it after typing
a password you defined. This feature permits you to leave your station, keeping 
information confidential or secure until you come back and the defined password is 
entered. 

For maximum confidentiality, during the locking process all applications are 
minimized leaving only an Enter Password dialog displayed. Applications running in 
the background which cannot run properly when minimized (for example, certain 
communication programs) are left untouched.

If you want to set or change your password, type the command PASSWORD in the 
Command Line Box or select Password in the Preferences dialog.

The Alt+Ctrl+Del (reboot) key combination can be disabled while your system is 
locked. For this feature to work properly, the device vrbtd.386 has to be declared in 
the [386Enh] section of SYSTEM.INI and the option has to be set in Preferences.



MaxFM

File Manager

Purpose: Enlarges File Manager Window to its maximum size.

Syntax: MAXFM    [/?]

Switch: /? Displays this command help topic.

Usage: With this command you can enlarge File Manager to fill the entire desktop, enabling 
you to display more information.
NOTE: You can also maximize File Manager by double-clicking its title bar. To restore
it to its previous size, double-click the title bar again. 



Mem

Internal

Purpose: Displays free memory (RAM) and largest available memory block in kBytes, and free
resources in %.

Syntax: MEM    [/?]

Switch: /? Displays this command help topic.

Usage: The MEM command is a fast way to get information about your memory (RAM) 
usage. Identical information is provided in the Abgut WizManager dialog box 
accessed from the WizManager menu.

See also: DiskFree command



MinApp

Internal

Purpose: Reduces all running applications to icons, except File Manager.

Syntax: MINAPP    [/?]

Switch: /? Displays this command help topic.

Usage: The MINAPP command lets you quickly minimize all the running applications but still
continue to work with File Manager. Applications running in the background which 
cannot run properly when minimized (for example, certain communication programs)
are left untouched.

You can access the same functionality from the WizManager popup menu displayed 
when clicking with the right mouse button anywhere on File Manager.



MinFM

File Manager

Purpose: Reduces File Manager to an icon.

Syntax: MINFM    [/?]

Switch: /? Displays this command help topic.

Usage: When you are finished working with File Manager, you may want to reduce it to an 
icon so that File Manager is available for later use. To do so, simply type MINFM or 
select Minimize from the Windows system menu.

When you reduce File Manager to an icon, File Manager continues to run but its 
window does not take up space on the desktop. 



MinWin

Internal

Purpose: Reduces all File Manager directory and Search Result windows to icons. 

Syntax: MINWIN    [/?]

Switch: /? Displays this command help topic.

Usage: The WINMIN command is a fast way to minimize all the displayed windows in File 
Manager. 

With a very busy File Manager (many open windows), it is sometimes better to 
minimize all the windows and restore only the ones needed for a certain task, tiling 
them horizontally or vertically if necessary. 



MkDir or MD

Internal

Purpose: Creates a subdirectory.

Syntax: MKDIR [drive:] path  [/?]
or
MD [drive:] path  [/?]

Parameters: [drive:] Specifies the drive on which the new directory is created.
path Specifies the name and location of the new directory.

Switch: /? Displays this command help topic.

Usage: The Make Directory command (MKDIR or its short form MD) creates subdirectories 
in the root directory or other subdirectories.

If a backslash (\) is included before the first subdirectory name in the directory path, 
MD begins the path to the new subdirectory at the root directory of the current or 
specified drive. Without a backslash, MD begins the path from the current directory 
of the current or specified drive.

The path from the current directory leading to the new subdirectory must be entered 
and all subdirectories in the path must exist.

The maximum length of any single path from the root directory to the final directory 
is 63 characters, including backslashes.    

DOS file naming conventions have to be followed when creating a new directory. 

Examples: To create the directory \SALES under the root directory, 
type:  md \sales
To create the directory \DOCUMENT under the current directory \CLIENTS, 
type:    md document



Mouse 

Control Panel

Purpose: Opens the Control Panel Mouse dialog which allows you to change your mouse 
settings.

Syntax: MOUSE    [/?]

Switch: /? Displays this command help topic.

Usage: Using the Control Panel Mouse option, you can customize your pointing device. If 
you are using a mouse, you may be able to swap the right and left mouse button and
adjust the double-click and tracking speeds. The options you can set depend on the 
pointing device you are using. For information about these options, see the 
documentation that comes with your pointing device or use the Help feature, if 
available. 



Move,  MoveQ

Internal

Purpose: Moves one or more files to another location.

Syntax: MOVE source [destination] [/A /H /S /P /N /V /?]
or
MOVEQ source [destination] [/A /H /S /N /V /?]

Parameters: source Specifies the path and name of a file or set of files which will be 
moved.

destination Specifies the path and name of a file or a directory or a device to 
move to.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files.
/P Prompts to confirm each file before it is moved.
/N No confirmation prompt.
/V Verifies that files are written correctly. Destination file content    and source 

file content are compared    to assess the accuracy of the moving process.
/? Displays this command help topic.

Usage: The MOVE command is used to relocate one or more files to another location either 
on the same disk or another disk. MOVE can also be used to combine files together 
into one file.

If the destination specification is omitted, the move is done to the current directory 
on the current drive, keeping the same file name, creation date, and creation time. It 
is not possible to move a file onto itself. Wildcards (? and *) can be used in the 
source and the destination file specifications.

A confirmation dialog is displayed if the destination file specification matches one 
already on the destination drive.

If the destination specification    is a drive or directory name, then the source files are
move individually to the new location.    If the destination specification is a file name, 
the first source file is moved to the destination, and any additional source files are 
then appended to the new destination file.

DOS file naming conventions have to be followed when renaming files during a 
move. 

You can press the ESC key (Escape key) at any time to interrupt MOVE.

The MOVEQ command has the same format as the MOVE command. MOVEQ 
automatically displays the name of the file to move and asks you for confirmation 
before completing the move. MOVEQ is most useful when used with the wildcard 
characters ? and * to move a group of files. MOVEQ is equivalent to MOVE with /P 
switch.

Examples: To move the file REPORT.DOC from your current drive to the floppy disk in drive A: 



type:    move report.doc a:
To move all the files in the directory PROSPECT to the directory CLIENT, 
type:    move \prospect \client    or    move \prospect\*.* \client  

To move and rename the file CHAP8.TXT in the current directory to SECTION8.TXT 
in the directory MYBOOK, 
type:    move chap8.txt \mybook\section8.txt  



NetCon

File Manager

Purpose: Opens File Manager Network Connections dialog which allows you to connect to or 
disconnect from a network drive.

Syntax: NETCON    [/?]

Switch: /? Displays this command help topic.

Usage: You can use this File Manager feature to connect to and disconnect from a network 
drive. When you quit Windows, your network connections are saved, and then made
again when you restart Windows. With some networks, you can turn off this feature 
by changing your network settings in Windows Control Panel. Depending on your 
network, you may have one command for connecting to and disconnecting from a 
network (Network Connections) or two commands (Connect Network Drive and 
Disconnect Network Drive).



NetDis or NetDel

File Manager

Purpose: Opens File Manager Network Connections or Disconnect Drive dialog (depending on
your network) which allows you to disconnect your system from a network drive. 

Syntax: NETDIS    [/?]
or
NETDEL    [/?]

Switch: /? Displays this command help topic.

Usage: You can use File Manager to connect to and disconnect from a network drive. When 
you quit Windows, your network connections are saved, and then made again when 
you restart Windows. With some networks, you can turn off this feature by changing 
your network settings in the Windows Control Panel. Depending on your network, 
you may have one command for connecting to and disconnecting from a network 
(Network Connections) or two commands (Connect Network Drive and Disconnect 
Network Drive).      



Network 

Control Panel

Purpose: Opens the Control Panel Network dialog which allows you to specify settings for 
your network connections.

Syntax: NETWORK    [/?]

Switch: /? Displays this command help topic.

Usage: The Control Panel Network option can be used to control your connection to the 
network. Depending on your network software, you can specify network options or 
perform tasks such as signing on and off the network, changing your user ID and 
password, sending messages to other network users, and restoring network 
connections when you start Windows.

NOTE: This option is available only if you have a network installed and started. 



NewWin

File Manager

Purpose: Opens a new File Manager directory window.

Syntax: NEWWIN    [/?]

Switch: /? Displays this command help topic.

Usage: It is useful to have more than one file Manager directory window open if you want to 
display the contents of two directories at once, or if you want to move or copy files 
from one drive to another. To open a new directory window you can either type the 
NEWWIN command, double-click a drive icon or choose New Window from the 
Window menu. In the latter case, the window displays the same drive and directory 
information as the directory window that was active before you used this command. 
The new window displayed has the same display settings as the one that was active 
when you opened it (View settings, etc.). 

NOTE:  If you want to open a directory window that displays only the contents of a 
particular directory, press and hold down SHIFT while you double-click the directory 
icon in the directory tree. A new directory window appears, displaying the contents of
that directory.        



Open

Internal

Purpose: Opens the selected files in File Manager directory window. 

Syntax: OPEN    [/?]

Switch: /? Displays this command help topic.

Usage: The OPEN command displays the Open Files dialog which lets you open ALL (more 
than one at a time) the files selected in File Manager. You can either open the files 
according to their associations (extensions), according to a specified association (for
example program associated with the TXT extension), or a specified program name 
(Browse to find application path, or enter it directly). All the files can also be sent to 
the same application.

Because of a File Manager problem, this command is only available when at least 
one file or directory is selected in the directory window. 



Password

Internal

Purpose: Sets or changes the unlock password.

Syntax: PASSWORD    [/?]

Switch: /? Displays help information for the command.

Usage: The PASSWORD command is used to assign a password to unlock WizManager's 
LOCK feature. LOCK minimizes all running applications and locks Windows until you
enter your password in the displayed Unlock dialog.

A password can be any combination of letters, numbers, and/or punctuation. Spaces
(space bar spaces) are accepted. For maximum security, it is strongly suggested 
NOT to use passwords shorter than 4 characters. It is also wise NOT to use 
passwords such as birthdays or first names. These are often the first ones tried by 
anyone who would try to break into your system.



Path

Internal

Purpose: Displays the search path.

Syntax: PATH    [/?]

Switch: /? Displays this command help topic.

Usage: The PATH command is used to check or look up the current search paths of your 
system. Incorrect information in the paths, such as non-existent directory 
declarations, will not be found until the specified paths are searched when, for 
example, executing a command or opening a file with its associated application.

The PATH command only displays the search paths. To edit the latter use the regular
DOS PATH command. You can quickly do so by typing WizManager ' : ' command 
formatter (without the quotes) in front of the PATH command in the Command Line 
Box.



PDetails

File Manager

Purpose: Opens File Manager View Partial Details dialog which allows you to display partial 
information on files and directories. 

Syntax: PDETAILS    [/?]

Switch: /? Displays this command help topic.

Usage: Use the PDETAILS command to display file information, such as file size, last 
modification date and time, and file attributes in a directory window. By default, only 
the names of files and directories are displayed. You can display all file information 
or specific types of information. 



Ports 

Control Panel

Purpose: Opens the Control Panel Ports dialog which allows you to specify communications 
settings for your serial ports.

Syntax: PORTS    [/?]

Switch: /? Displays this command help topic.

Usage: Using the Control Panel Ports option, you can specify basic settings, such as the 
baud rate and data, parity, and stop bits for your serial ports. You can also specify 
advanced settings that determine the I/O address and the interrupt request line 
(IRQ) that Windows uses to send information to a serial port. 

NOTE: If you plan to use only serial ports COM1 and COM2, you may need to 
change only the basic settings. If you plan to use COM3 and COM4, you may also 
need to change the advanced settings.    



Pref

Internal

Purpose: Opens WizManager Preferences dialog which allows you to set or change your 
configuration preferences.

Syntax: PREF    [/?]

Switch: /? Displays this command help topic.

Usage: With the Preferences dialog, you can customize WizManager to fit your preferences. 
You can specify whether to activate the right mouse button, to beep on errors, to 
move to Command Box at File Manager startup, to force the refreshing of File 
Manager after certain commands, to include hidden or system files in commands. 
You can set the commands confirmations, your password, WizManager startup 
directory, additional file search paths, and DOS PIF file name and path.

To customize WizManager Buttonbar, use the CUSTBAR command.



Print

Internal

Purpose: Prints a file.

Syntax: PRINT [drive:][path] filename  [/?] 

Parameters: [drive:][path] filename Specifies the location and name of the file to print. The 
filename cannot contain any wildcards (? or *).

Switch: /? Displays this command help topic.

Usage: The PRINT command lets you print a file without having to open it in an application. 
PRINT uses the file association to automatically load, open, print and close the file 
and its associated program. This is a fast and efficient way to quickly print a file. 



PrintDir

Internal

Purpose: Prints File Manager directory list. 

Syntax: PRINTDIR    [/?]

Switch: /? Displays this command help topic.

Usage: The PRINTDIR command opens the Print Directory dialog which allows you to print 
either the list of the selected files and directories in the File Manager directory 
window, or the entire directory listing.

PRINTDIR prints the disk's volume label, one directory or filename per line, including
the filename extension, the file size in bytes, the date and time the file was last 
modified, and the file's attributes. At the end of the listing, the total number of files, 
the total number of directories, the cumulative size of the files, and the free space 
remaining on the disk are also printed.

Because of a File Manager problem, this command is only available when at least 
one file or directory is selected in the directory window. 



Printers 

Control Panel

Purpose: Opens the Control Panel Printers dialog which allows you to install and remove 
printers, and set printing options.

Syntax: PRINTERS    [/?]

Switch: /? Displays this command help topic.

Usage: By using the Control Panel Printers option, you can install and remove printers, 
change printing settings, and select the printer you want to use as the default printer.

There are several steps to installing and configuring a printer to use with Windows, 
but first, you must install a printer driver that controls your printer. For information 
about installing a printer driver, see Installing a Printer Driver in your Windows 
manual. 

If you have already installed a printer driver, using this Control Panel option, you can
assign a port to the printer, change the time-outs settings, specify settings for your 
printer, choose the default printer, and connect to a network printer if a network is 
available.      



PrnTree

Internal

Purpose: Prints a selected disk's hierarchical directory structure. 

Syntax: PRNTREE [drive:]  [/F /S /?]

Parameter: [drive:] Specifies the drive which directory structure should be printed.

Switch: /F Prints the names of the files in each directory.
/S Prints the total size of each directory.
/? Displays this command help topic.

Usage: The PRNTREE command lets you print the entire directory structure of the specified 
drive. The structure that PRNTREE prints depends upon the switches, if any, you 
specify. 

PRNTREE can be very useful when you want a hard copy of your disk's hierarchical 
directory structure for directory size checking, file verification or archiving purposes. 

PRNTREE without parameter prints the directory structure of the current drive. 



Reboot

Internal

Purpose: Exits Windows and reboots (restarts) your system.

Syntax: REBOOT    [/?]

Switch: /? Displays this command help topic.

Usage: The REBOOT command executes an orderly shutdown sequence of windows and 
completely restarts your computer. A confirmation dialog is displayed before 
proceeding with the reboot. This can be changed in the Preferences dialog.

During the process, any running application with unsaved changes will ask for 
confirmation before closing. If all applications agree to quit, the Windows session is 
terminated and the system is restarted (cold reboot). The Reboot process is identical
to turning the power off and back on or pressing the reset button of your computer.    

A reboot is necessary to activate any changes to your CONFIG.SYS file, and may 
also be used if you wish to restart the system with an altered AUTOEXEC.BAT file, 
for example.



Refresh

File Manager

Purpose: Updates the active File Manager directory window.

Syntax: REFRESH    [/?]

Switch: /? Displays this command help topic.

Usage: You may want to use the REFRESH command to update a directory window if you 
have switched floppy disks or if you have connected to a network drive outside of 
File Manager.    



Ren,  RenQ

Internal

Purpose: Renames a file or files.

Syntax: REN oldname newname [/A /H /S /P /N /?]
or
RENQ oldname newname [/A /H /S /N /?]

Parameters: oldname Specifies the path and name of a file or set of files which will be 
renamed.

newname Specifies the new file name.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files. 
/P Prompts to confirm each file before it is renamed.
/N No confirmation prompt.
/? Displays this command help topic.

Usage: The REN command lets you rename a file or a group of files. This is particularly 
useful when you wish to further customize an existing filename or change its 
extension to an extension which has a specific association.

You will have to follow DOS file naming conventions for properly renaming files. 

You can use wildcards (? or *) in either the source or the destination filename. If you 
use wildcards in the newname, the characters represented by the wildcards will be 
identical to the corresponding characters in the oldname. 

You can press the ESC key (Escape key) at any time to interrupt REN.

You cannot specify a new drive or path in your destination filename. 
The REN command will not work if the newname is an existing file.

The RENQ command has the same format as the REN command. RENQ 
automatically displays the name of the file to rename and its new name and asks 
you for confirmation before completing the renaming. RENQ is most useful when 
used with the wildcard characters ? and * to rename a group of files. RENQ is 
equivalent to REN with /P switch.

REN and RENAME commands are synonyms, you can use either one.

Examples: To rename the file REPORT.DOC to REPORT.OLD, 
type:    ren report.doc report.old
To rename all the files in the DOCUMENT directory with the extension TXT to the 
same filenames but with the extension DOC, 
type:    ren \document\*.txt *.doc
 





Rename,  RenameQ

Internal

Purpose: Renames a file or files.

Syntax: RENAME oldname newname [/A /H /S /P /N /?]
or
RENAMEQ oldname newname [/A /H /S /N /?]

Parameters: oldname Specifies the path and name of a file or set of files which will be 
moved.

newname Specifies the new file name.

Switches: /A Includes system and hidden files.
/H Includes hidden files.
/S Includes system files. 
/P Prompts to confirm each file before it is renamed.
/N No confirmation prompt.
/? Displays this command help topic.

Usage: The RENAME command lets you rename a file or a group of files. This is particularly
useful when you wish to further customize an existing filename or change its 
extension to an extension which has a specific association.

You will have to follow DOS file naming conventions for properly renaming files. 

You can use wildcards (? or *) in either the source or the destination filename. If you 
use wildcards in the newname, the characters represented by the wildcards will be 
identical to the corresponding characters in the oldname. 

You cannot specify a new drive or path in your destination filename. 
The RENAME command will not work if the newname is an existing file.

You can press the ESC key (Escape key) at any time to interrupt RENAME.

The RENAMEQ command has the same format as the RENAME command. 
RENAMEQ automatically displays the name of the file to rename and its new name 
and asks you for confirmation before completing the renaming. RENAMEQ is mgst 
useful when used with the wildcard characters ? and * to rename a group of files. 
RENAMEQ is equivalent to RENAME with /P switch.

RENAME and REN commands are synonyms, you can use either one.

Examples: To rename the file REPORT.DOC to REPORT.OLD, 
type:    rename report.doc report.old
To rename all the files in the DOCUMENT directory with the extension TXT to the 
same filenames but with the extension DOC, 
type:    rename \document\*.txt *.doc



Restart

Internal

Purpose: Exits and restarts Windows.

Syntax: RESTART    [/?]

Switch: /? Displays this command help topic.

Usage: The RESTART command executes an orderly shutdown sequence of windows, exits
and restarts Windows. A confirmation dialog is displayed before proceeding with the 
restart. This can be changed in the Preferences dialog.

During the process, any running application with unsaved changes will ask for 
confirmation before closing. If all applications agree to quit, the Windows session is 
terminated and a new Windows session is created. The RESTART process is 
identical to completely exiting Windows and restarting it from the DOS prompt.    

A restart is necessary to activate any changes to your SYSTEM.INI file, and may 
also be used if you wish to restart the system with an altered WIN.INI file, for 
example.



RestApp

Internal

Purpose: Restores all minimized applications to their original size.

Syntax: RESTAPP    [/?]

Switch: /? Displays this command help topic.

Usage: The RESTAPP command lets you quickly restore all minimized applications without 
losing the focus in File Manager.

You can access the same functionality from the WizManager popup menu displayed 
when clicking with the right mouse button anywhere on File Manager. 



RestWin

Internal

Purpose: Restores all minimized or maximized File Manager directory and Search Result 
windows. 

Syntax: RESTWIN    [/?]

Switch: /? Displays this command help topic.

Usage: The RESTWIN command is a fast way to restore all the minimized and maximized 
windows in File Manager to their previous size and location. 



RmDir or RD

Internal

Purpose: Removes a subdirectory.

Syntax: RMDIR [drive:] path  [/?]
or
RD [drive:] path  [/?]

Parameters: [drive:] path Specifies the location and name of the directory to delete.

Switch: /? Displays this command help topic.

Usage: The Remove Directory command (RMDIR or its short form RD) removes a specified 
subdirectory in the root directory or other subdirectories. The subdirectory to be 
deleted must be empty except for the (.) and (..) markers which refer to the directory 
itself, and its parent directory, and cannot be deleted. Verify that no hidden or system
file remains in the subdirectory to removed. 

It is not possible to remove the current working directory.

If a backslash (\) is included before the first subdirectory name in the directory path, 
RD begins the path to the subdirectory to remove at the root directory of the current 
or specified drive. Without a backslash, RD begins the path from the current 
directory of the current or specified drive.

The path from the current directory leading to the subdirectory to remove must be 
entered and all subdirectories in the path must exist.

Examples: To remove the directory \SALES under the root directory, 
type:    rd \sales
To remove the directory \DOCUMENT under the current directory \CLIENTS, 
type:    rd document



SaveNow

Internal

Purpose: Saves positions and views of open File Manager directory windows. 

Syntax: SAVENOW    [/?]

Switch: /? Displays this command help topic.

Usage: The SAVENOW command lets you immediately save the positions and views of 
open File Manager directory windows. When you restart File Manager, the open 
directory windows will be in the same positions and have the same View menu 
settings as they had at the time you used this command. With SAVENOW you don't 
have to set the Save Settings on Exit menu command and close File Manager in 
order to keep the directory windows layout. It is saved at the time you use the 
SAVENOW command.

NOTE:    Holding down the SHIFT key while selecting the Exit command from the 
File menu has the same effect as SAVENOW.    



Search

File Manager

Purpose: Opens File Manager Search dialog which allows you to search for files and 
directories on all or part of a specified drive.

Syntax: SEARCH    [/?]

Switch: /? Displays this command help topic.

Usage: To find a file or group of files, you can use the Search command. If files are found, 
they are listed in the Search Results window. You can select items in this window 
and perform such tasks as copying, deleting, moving, and printing files. The contents
of the Search Results window changes when you perform a new search.    

Use WizManager Print Search List    to print the listing of the files selected in the 
Search Results window.



SelDrive

File Manager

Purpose: Opens File Manager Select Drive dialog which lets you to select a particular disk 
drive. 

Syntax: SELDRIVE    [/?]

Switch: /? Displays this command help topic.

Usage: With the SELDRIVE command you can change the drive displayed in the active 
directory window. The drive list presented in the dialog displays short information 
about the available drives. This can be useful when you have to select a specific 
network drive, for example, and preferred over selecting a drive by clicking its icon 
which displays the drive letter only.    



Select

File Manager

Purpose: Opens File Manager Select Files dialog which allows you to select files and 
directories in the active directory window.

Syntax: SELECT    [/?]

Switch: /? Displays this command help topic.

Usage: Before you can work with a file in File Manager, you must select it. There are several
ways to select files in File Manager. If the files you want are visible in the directory 
window, you can use the mouse or keyboard to quickly select them. If the files are 
not visible, or if you want to select a group of files with similar names, use the 
SELECT command. 

Through the displayed Select dialog you can quickly select or unselect a file or group
of files.    



ShDir or SD

File Manager

Purpose: Opens File Manager Share As dialog which allows you to share directories with 
others on a network. 

Syntax: SHDIR    [/?]
or
SD    [/?]

Switch: /? Displays this command help topic.

Usage: This command is only available with Windows for Workgroups.

If Windows for Workgroups is running in 386 enhanced mode, you can share a 
directory (or several directories) with others. When you share a directory, you give 
others access to all the files and subdirectories in that directory. 

When sharing a directory, you specify a share name and you can specify a password
indicating the type of access other people can have to the shared directory. 
Passwords can grant a person read-only access or full access. Those who have full-
access passwords can read, change, delete, or create files in your shared directory 
and its subdirectories. Those who have read-only passwords can only read files and 
run applications. If you do not specify a password, anyone can have access to your 
shared directory. 



SortDate

File Manager

Purpose: Sorts File Manager files in the active directory window by their last modification 
dates. The most recently modified files are listed first. 

Syntax: SORTDATE    [/?]

Switch: /? Displays this command help topic.

Usage: By default, files are listed alphabetically by name (see SORTNAME command). 
However, you can choose to display files by date with the most recently modified file 
listed first using the SORTDATE command, or alphabetically by their extension (see 
SORTTYPE command), or by size from largest to smallest (see SORTSIZE 
command). 



SortName

File Manager

Purpose: Sorts File Manager files and directories in the active directory window alphabetically 
by name. Directories are listed first, then files.

Syntax: SORTNAME    [/?]

Switch: /? Displays help information for the command.

Usage: By default, files are listed alphabetically by name. If the files are sorted differently 
use the SORTNAME command to display them again alphabetically by name. You 
can choose to display files alphabetically by their extension (see SORTTYPE 
command), by size from largest to smallest (see SORTSIZE command), or by date, 
with the most recently modified files listed first (see SORTDATE command).    



SortSize

File Manager

Purpose: Sorts File Manager files in the active directory window by size, from largest to 
smallest.

Syntax: SORTSIZE    [/?]

Switch: /? Displays this command help topic.

Usage: By default, files are listed alphabetically by name (see SORTNAME command). 
However, you can choose to display files by size from largest to smallest using the 
SORTSIZE command, or alphabetically by their extension (see SORTTYPE 
command), or by date with the most recently modified files listed first (see 
SORTDATE command). 



SortType

File Manager

Purpose: Sorts File Manager files and directories in the active directory window alphabetically 
by extension. Directories are listed first, then files. 

Syntax: SORTTYPE    [/?]

Switch: /? Displays this command help topic.

Usage: By default, files are listed alphabetically by name (see SORTNAME command). But 
you can choose to display files alphabetically by their extension with the SORTTYPE
command, or by date with the most recently modified files listed first (see 
SORTDATE command), or by size from largest to smallest (see SORTSIZE 
command). 



Sound 

Control Panel

Purpose: Opens the Control Panel Sound dialog which allows you to assign sounds to system 
events.

Syntax: SOUND    [/?]

Switch: /? Displays this command help topic.

Usage: Use the Control Panel Sound option to assign sounds to system and application 
events and to turn the Windows warning beep and system sounds on or off. You can 
assign sounds only if you have a sound card installed in your computer& If you don't 
have a sound card installed, the lists of sounds and events appear dimmed. 

NOTE: A Microsoft® speaker driver which can play WAV sound files is available from
Microsoft® Corporation and other various sources (CompuServe, bulletin boards, 
etc.), but is not shipped with Windows and is not supported by Microsoft® because 
of existing incompatibilities with certain systems. This speaker driver, once installed, 
will enable the sounds list. 



StopSh or SS

File Manager

Purpose: Opens File Manager Stop Sharing dialog which allows you stop sharing directories 
with others on a network. 

Syntax: STOPSH    [/?]
or
SS    [/?]

Switch: /? Displays this command help topic.

Usage: This command is only available with Windows for Workgroups.

You can stop sharing a directory if you no longer want other people to have access 
to the files in the directory. 

NOTE:    If you stop sharing a directory, those who are using files in the shared 
directory may lose data. 



Sys

File Manager

Purpose: Opens File Manager Make System Disk dialog which allows you to copy DOS 
operating-system files onto a formatted floppy disk. 

Syntax: SYS    [/?]

Switch: /? Displays this command help topic.

Usage: The SYS command creates a bootable system disk out of a formatted floppy disk. A 
system disk can start a computer that uses the DOS operating system.



SysInfo

Internal

Purpose: Displays information about your computer and Windows configuration.

Syntax: SYSINFO    [/?]

Switch: /? Displays this command help topic.

Usage: If you have questions about your computer and Windows configuration, SYSINFO is 
a handy command to use. It instantly displays information about your system in a 
single dialog box. You are able to see at a glance how much memory you have 
available,    what your CPU, video type and resolution are, and if you have a 
coprocessor. It displays the system date and time, WizManager, DOS and Windows 
versions, whether you are connected to a network, and gther critical information. 



Task

Internal

Purpose: Displays WizManager popup Task menu.

Syntax: TASK    [/?]

Switch: /? Displays this command help topic.

Usage: The TASK command displays WizManager's popup Task menu which lets you pick 
one of your Launch submenus, Customize Launch Menus, Minimize, Restore or 
Close active applications, or start the Task Manager. A list of the currently running 
applications is also displayed, allowing you to quickly jump to any of them.

The Task menu can also be displayed by clicking anywhere on File Manager with the
right mouse button.    



TileH

File Manager

Purpose: Arranges directory windows on top of each other    (horizontally) so that each window
is visible and no windows overlap. 

Syntax: TILEH    [/?]

Switch: /? Displays this command help topic.

Usage: If several directory windows are open, you may need to arrange the windows so that
you can see them all. Tiling the windows horizontally or vertically is a very useful 
feature which lets you navigate through the different windows with ease. When many
windows are displayed, tiling horizontally or vertically becomes equivalent. In this 
situation, cascading the windows becomes often more efficient. 

With a very busy File Manager (many open windows), it is sometimes better to 
minimize all the windows and restore only the ones needed for a certain task, tiling 
them horizontally or vertically if necessary.      



TileV

File Manager

Purpose: Arranges directory windows side by side (vertically) so that each window is visible 
and no windows overlap. 

Syntax: TILEV    [/?]

Switch: /? Displays this command help topic.

Usage: If several directory windows are open, you may need to arrange the windows so that
you can see them all. Tiling the windows horizontally or vertically is a very useful 
feature which lets you navigate through the different windows with ease. When many
windows are displayed, tiling horizontally or vertically becomes equivalent. In this 
situation, cascading the windows become often more efficient. 

With a very busy File Manager (many open windows), it is sometimes better to 
minimize all the windows and restore only the ones needed for a certain task, tiling 
them horizontally or vertically if necessary.      



Time 

Control Panel

Purpose: Opens the Control Panel Date/Time dialog which allows you to change the time of 
your computer's clock.

Syntax: TIME    [/?]

Switch: /? Displays help information for the command.

Usage: By using the Date/Time Control Panel option, you can change the date and time of 
your system's clock. The format of the date and time is set with the Short Date and 
Time Format options in the International settings dialog box. 

It is important that your system's date and time are always accurate. Many 
applications, including File Manager, Clock, and Calendar, use your system's date 
and time to record important information. 



Type

Internal

Purpose: Displays the contents of a text file.

Syntax: TYPE [drive:][path] filename  [/?]

Parameters: [drive:][path] filename Specifies the location and name of the file to view.

Switch: /? Displays this command help topic.

Usage: The TYPE command displays the contents of a text file on the screen. The 
application associated with the file extension TXT is used for this purpose. 
Displaying a program file or a binary file only shows unintelligible characters.

Example: To display the file READ.ME, 
type:  type read.me



Ver

Internal

Purpose: Displays the current WizManager, DOS, and Windows versions.

Syntax: VER    [/?]

Switch: /? Displays this command help topic.

Usage: Use this command to identify the currently running versions of    WizManager, DOS 
and Windows.



Verify

Internal

Purpose: Enables or disables disk-write verification or displays the verification state.

Syntax: VERIFY [ON | OFF]  [/?]

Switches: [ON | OFF] Specifies whether to verify that the write operations are done correctly.
The ON value enables the verification process. The OFF value 
disables it.

/? Displays this command help topic.

Usage: With VERIFY ON, data written to the disk is checked for correctness after each write 
operation. 

Entering the VERIFY command without a switch displays whether VERIFY is 
currently ON or OFF.

Turning VERIFY ON slightly slows down all disk-write operations.

Example: To check the current status of VERIFY, 
type:    verify
To switch VERIFY ON, 
type:    verify on



Vol

Internal

Purpose: Displays a disk volume label.

Syntax: VOL [drive:]  [/?]

Switch: /? Displays this command help topic.

Parameters: [drive:] Specifies the drive whose volume label should be displayed.

Usage: The VOL command displays the volume label of the specified drive, or of the default 
drive if no drive is given. 



Naming Files and Directories

Rules to follow for naming files and directories:

The name of a file or directory can have two parts: a name and an optional extension. The two parts are
separated by a period (for example, YOURFILE.NEW). The name can contain up to eight characters, 
and the extension can contain up to three characters. The name must start with either a letter or 
number. It can contain any uppercase or lowercase character except the following: 

period (.) quotation mark (") 
slash (/) backslash (\) 
brackets ([ ]) colon (:) 
semicolon (;) vertical bar (|) 
equal sign (=) comma (,) 

If you use these characters in a filename, you may get unexpected results. The name cannot contain 
any spaces. The following names are reserved and cannot be used for files or directories: CON, AUX, 
COM1, COM2, COM3, COM4, LPT1, LPT2, LPT3, PRN, and NUL. 

Examples of valid filenames are LETTER.DOC, MEMO.TXT, BUDGET.93, and 2NDTRY.RPT.



Preferences: General Setup

General Setup Check Boxes:

Option Description
____________________________________________________________________________

Activate Right Mouse Button. Check this box if you want to display the WizManager Popup 
menu when clicking with the right mouse button anywhere on 
File Manager.

Move to Command Line Box 
at Startup.    Check this box if you want the Command Line Box to be active 

and ready for command entries when File Manager is started.

Beep on Error.    Check this box if you want WizManager to emit a beep when an
error is detected.

Display Button Info  in Buttonbar Check this box to display a help window when the mouse cursor
is positioned over a Buttonbar button.

Display Button Info  in Launchbar Check this box to display a help window when the mouse cursor
is positioned over a Launchbar button.

3D Effects in Dialogs This options lets you chose if you want to have 3-dimensional 
effects in the dialogs. Select 'No 3D effects' to ignore these 
effects. 'WizManager dialogs only' will transform only the 
WizManager dialogs. 'All File Manager dialogs' will make all the 
File Manager dialogs 3D dialogs.
Note:    With 'All File Manager dialogs', some static text controls 
will appear without a 3D effect in some File Manager dialogs.

See also:
Preferences: System Setup 
Preferences: Popup Menu 
Preferences: Command Confirmations      
Preferences: File List in Dialogs: Preferences: Zip/UnZip    



Preferences: Command Confirmations

Command Confirmations Check Boxes:

Option Description
____________________________________________________________________________

File Copy. Check this box to have a confirmation dialog displayed each time 
WizManager's COPY command is used.

File Move.  Check this box to have a confirmation dialog displayed each time 
WizManager's MOVE command is used.

File Replace.  Check this box to have a confirmation dialog displayed before a 
WizManager's command is executed when a file declared in the source 
parameter has the same filename as an existing file in the target directory.

File Delete.    Check this box to have a confirmation dialog displayed each time 
WizManager's DELETE command is used.

File Rename.  Check this box to have a confirmation dialog displayed each time 
WizManager's RENAME or REN commands are used.

Directory Remove. Check this box to have a confirmation dialog displayed each time 
WizManager's RMDIR or RD commands are used.

Include Hidden Files. Check this box if you want WizManager's commands to always include 
hidden files.

Include System Files. Check this box if you want WizManager's commands to always include 
system files.

Force Refresh.    Check this box if you want to force File Manager to refresh its Status Bar and
its Directory window each time WizManager (not File Manager) performs a 
COPY, MOVE, or DELETE command.

See also:
Preferences: General Setup      
Preferences: System Setup 
Preferences: Popup Menu 
Preferences: File List in Dialogs
Preferences: Zip/UnZip    



Preferences: Popup Menu

Include in Popup Menu Check Boxes:

Option Description
____________________________________________________________________________

Launch Menus. Check this box if you want the popup menu to include the Launch Menus.

File Commands. Check this box if you want the popup menu to include File Commands (Copy, 
Move, Delete, etc.).

Task Commands. Check this box if you want the popup menu to include Task Commands.

Task List. Check this box if you want the popup menu to include a Task List.

Hidden Tasks. Check this box if you want to include hidden tasks in the Task List.

See also:
Preferences: General Setup      
Preferences: Command Confirmations      
Preferences: System Setup 
Preferences: File List in Dialogs
Preferences: Zip/UnZip    



Preferences: System Setup

System Setup Options:

Option Description
____________________________________________________________________________

Password... Lets you set or change your Unlock password.

Startup Directory... Lets you set the Command Line Box current directory when File Manager
is started.

Additional Path... Lets you append additional path searches to your current path.

Path Shortcut... Lets you choose the symbol which represents the active File Manager 
directory window path.

DOS PIF File... Lets you specify the DOS PIF file path and filename.

Set Fast Open... Lets you set the Fast Open applications.

Activate Open Files dlg 
when no Association If this option is set, starting a file which doesn't have an association will 

not bring up an error message. Instead the WizManager Open Files 
dialog will be displayed letting you chose how the file should be opened.

Replace File Manager's 
Icon and Title If this option is set, File Manager's icon will become the WizManager icon

when minimized and File Manager's title bar will read 'File WizManager'.

Disable Alt+Ctrl+Del 
when Locking If this option is set, Alt+Ctrl+Del (reboot) will be disabled while your 

system is locked. For this feature to work properly, the device vrbtd.386 
has to be declared in the [386Enh] section of SYSTEM.INI.

Confirm on Exit, 
Restart and Reboot If this option is set, no confirmation dialog will be displayed when 

executing the Exit Windows, Restart Windows or Reboot System 
commands.

See also:
Preferences: General Setup      
Preferences: Command Confirmations      
Preferences: Popup Menu 
Preferences: File List in Dialogs
Preferences: Zip/UnZip    



Preferences:    File List in Dialogs

File List in Dialogs Options:

Option Description
____________________________________________________________________________

File Icon Size Select which size the file icons should be in the results dialog of 'Find 
Files', 'Find Duplicates', and 'Synchronize Directories'.    File list 
scrolling is the fastest if no icons are presented in the file lists as each 
new icon is read from the disk when the list is scrolled.

Confirm on File Delete Check this box to have a confirmation dialog displayed each time you 
delete a file from the results dialog of 'Find Files', 'Find Duplicates', and
'Synchronize Directories'.

See also:
Preferences: General Setup      
Preferences: System Setup 
Preferences: Command Confirmations      
Preferences: Popup Menu 
Preferences: Zip/UnZip    



Preferences:    Zip/UnZip

Zip/UnZip Options:

Option Description
____________________________________________________________________________

Default Decryption Password
when Launching a File Enter a default password in the edit box which will be used 

when launching an encrypted file from a Zip file. This 
password will only be used during the launch process. The 
encrypt/decrypt passwords of the Zip/Add and UnZip/Extract 
features have to be entered in the corresponding Zip/Add and
UnZip/Extract dialogs.

Confirm on File Delete Check this box to have a confirmation dialog displayed each 
time you delete a file in a Zip file.

See also:
Preferences: General Setup      
Preferences: System Setup 
Preferences: Command Confirmations      
Preferences: Popup Menu 
Preferences: File List in Dialogs



Password

The    Password dialog allows you to assign a password to unlock WizManager's Lock feature. 
Lock minimizes all running applications and locks Windows until you enter your password in 
the displayed Unlock dialog.

To enter a (new) password, select the Preferences menu item in the WizManager menu, then select 
the Password... button in the System Setup group. The Password dialog displayed allows you to enter 
the password to unlock your system. You can also type PASSWORD in the Command Line Box to 
access the password dialog directly.

A password can be any combination of letters, numbers, and/or punctuation. Spaces (space bar 
spaces) are accepted. For maximum security, it is strongly suggested NOT to use passwords shorter 
than 4 characters. It is also wise NOT to use passwords such as birthdays or first names. These are 
often the first ones tried by anyone who would try to break into your system.

Entering a new password erases the previously saved password.

See also:
Preferences



Startup Directory

The    Startup Directory dialog allows you to assign the Command Line Box current directory 
when WizManager's Buttonbar is displayed (either at WizManager's startup or later when you 
select to display the Buttonbar).

To enter a new startup directory or to modify an existing one, select the Preferences menu item in the 
WizManager menu, then select the Startup Directory... button in the System Setup group. 

In the Startup Directory dialog, select to either use the directory which is current when the 
Buttonbar is displayed as the Command Line Box current directory or enter a startup directory in the 
dialog's edit field. 

See also:
Preferences



Additional Path

In addition to the DOS search PATH, WizManager will search the path set in the Additional Path 
for commands, programs, files or scripts not found in the current directory.

To enter an additional path or to modify an existing one, select the Preferences menu item in the 
WizManager menu, then select the Additional Path... button in the System Setup group. 

In the Additional Path dialog, select no additional path or enter a path or set of paths in the 
dialog's edit field. To specify a set of paths to search, separate the entries with a semi-colon (;).

See also:
Preferences



Path Shortcut

The path shortcut symbol represents the path of the active File Manager directory window.

The path shortcut symbol (character) is a command parameter prefix which is useful when the current 
Command Line Box directory differs from the active File Manager directory window directory. The path 
shortcut symbol represents the full path of the active File Manager directory. It allows you to work on the
files displayed in the active File Manager directory window from the Command Line Box with a 
minimum of keystrokes. To fully specify a file displayed in the active File Manager window, simply enter 
the path shortcut symbol followed by the filename. 

To select a Path Shortcut symbol, select the Preferences menu item in the WizManager menu, then 
select the Path Shortcut... button in the System Setup group. 

The path shortcut symbol can be either:

; (a semi-colon)
+ (a plus sign)
@ (the at character)
or no path shortcut symbol activated.

The default path shortcut symbol is the semi-colon character (;). The path shortcut symbol can 
be changed by selecting another dialog option in the Select A Path Shortcut Symbol group.

See also
Path Shortcut Examples 
Preferences



Path Shortcut Examples

In the following examples, the path shortcut symbol is chosen to be the default path shortcut 
symbol, the semi-colon (;). 

To change the Command Line Box current directory to the active File Manager directory window, 
type:    cd ;

To change the Command Line Box current directory to the directory CLIENTS located beneath 
the active File Manager directory window, type:    cd ;\clients

To copy all the files from the active File Manager directory window to the A: drive, type:    
copy ;\*.* a:

To create the directory PROJECT in the active File Manager directory window, type:    md ;\
project

Note: For all commands, entering the path shortcut symbol alone or followed by a BackSlash (\)    is 
equivalent, i.e. for example, typing cd ;\clients is equivalent to typing    cd ;clients.

See also:
Preferences



DOS PIF File

When WizManager opens a DOS Prompt session, it executes the program named 
COMMAND.COM through a PIF configuration file specified in the DOS PIF File Preferences. 

DOSPRMPT.PIF is the default configuration file which is installed in your Windows directory when 
Windows is installed. DOSPRMPT.PIF is also the default configuration file preset by WizManager. To 
enter the path and filename of a different configuration file, select the Preferences menu item in the 
WizManager menu, then select the DOS PIF File... button in the System Setup group. 

The DOS PIF configuration file controls several facets of the way COMMAND.COM is launched from 
the DOS Prompt command. You can set or modify a PIF file using the Windows application 
PIFEDIT.EXE. Refer to the "PIF Editor" chapter of your Windows User's Guide for detailed information 
on how to customize a PIF file.

You can set a different path or a different PIF file than DOSPRMPT.PIF in the DOS PIF File 
Preferences dialog. Enter the PIF path and filename in the edit field or select Browse to browse through 
your drives and directories and find the appropriate PIF file.

See also:
Preferences



Set Fast Open

Set Fast Open allows you to set two applications which can be quickly accessed to open or 
work on the selected files in File Manager. When a Fast Open application is executed, the Open 
Files dialog is not displayed.

To set the Fast Open application paths and filenames, select the Preferences menu item in the 
WizManager menu, then select the Set Fast Open... button in the System Setup group. 

The application specified in the upper edit field is launched and opens the selected files in File Manager
when you hold down the Ctrl key while selecting Open Files from the WizManager menu or the Open 
Files button in the Buttonbar. The second application is selected and launched when you hold down the
Ctrl+Shift keys while selecting Open Files from the WizManager menu or the Open Files button in the 
Buttonbar

Enter the path and filename of the Fast Open applications in the respective edit fields or select 
the corresponding Browse button, browse through your drives and directories and set the appropriate 
Fast Open application.

See also:
Preferences



Customize Launch Menus

Select Customize | Launch Menus from the WizManager menu to access the Customize Launch 
Menus dialog.

From the Customize Launch Menus dialog, you can insert, modify or delete menu items which can be 
selected in the WizManager menu or in WizManager's popup menu, under the Launch menu item. The 
order of the menus can also be modified from the Customize Launch Menus dialog.

Insert a new menu item:
1. If you wish to specify the location of the new menu item within the menu items, select the menu 

item in the menu item list under which you would like to insert a new menu item. If no menu item 
is selected, the new menu item is inserted at the end of the list.

2. Select the Insert...    button and enter the menu item text, the command to execute, the working 
directory and the access command in the displayed dialog.

Modify an existing menu item:
1. Select the menu item to modify in the menu item list.
2. Select the Modify...    button. The menu item text, the command to execute, the working directory 

and the access command can then be modified in the displayed dialog. 

Delete a menu item:
1. Select the menu item to delete in the menu item list.
2. Select Ok in the confirmation dialog to delete the menu item.

Set the order of the menu items:
1. Select the menu item you wish to move in the menu item list.
2. Select the Move Up button to move the menu item up or the Move Down button to move the 

menu item down in the list.
3. Repeat steps 1. and 2. for each menu item you wish to move until you are satisfied with the 

results.



Insert Menu Item

The Insert Menu Item dialog allows you to specify the different parameters of the new menu 
item.

Menu Text:
Enter the text of the menu item as you wish it to appear under the Launch menu. If you want to 

choose the command from the menu by typing one of the letters of the menu item text, put an ampersand 
(&) immediately before that letter. Launch will display the menu item with that letter underlined. Entering 
the menu text is optional; if no menu text is specified, then the Command Line is displayed as the menu 
item text.

Command Line:
Enter the command to execute, the program to start or the file to open. You can select the Browse

button to browse through your directories and drives to select a file. Command switches can be specified.

Working Directory:
Enter the path of the directory which should be the working directory when the command 

specified in the Command Line is executed. Entering the working directory is optional.

Access with Command:
The command specified in the Command Line field can also be accessed and executed from the 

Command Line Box with the command you specify in the Access with Command field. 
The specified command name 

- Cannot be longer than 8 characters, 
- Cannot contain any space character and 
- Cannot be a WizManager command nor a command already specified in another menu item.



Modify Menu Item

The Modify Menu Item dialog allows you to modify each parameter of the selected menu item.

Menu Text:
Enter the text of the menu item as you wish it to appear under the Launch menu. If you want to 

choose the command from the menu by typing one of the letters of the menu item text, put an ampersand 
(&) immediately before that letter. Launch will display the menu item with that letter underlined. Entering 
the menu text is optional; if no menu text is specified, then the Command Line is displayed as the menu 
item text.

Command Line:
Enter the command to execute, the program to start or the file to open. You can select the Browse

button to browse through your directories and drives to select a file. Command switches can be specified.

Working Directory:
Enter the path of the directory which should be the working directory when the command 

specified in the Command Line is executed. Entering the working directory is optional.

Access with Command:
The command specified in the Command Line field can also be accessed and executed from the 

Command Line Box with the command you specify in the Access with Command field. 
The specified command name 

- Cannot be longer than 8 characters, 
- Cannot contain any space character and 
- Cannot be a WizManager command nor a command already specified in another menu item.



Print Directory

The Print Directory dialog allows you to print the listing of the selected files or to print the 
listing of all the files in the File Manager directory window. The directory listing can be sent to a 
printer (hard copy) or saved in a file.

The path of the files selected in File Manager is displayed at the top of the dialog with the number of 
selected files underneath.

You can choose to print the listing of only the selected files or the listing of all the files in the 
directory by selecting the appropriate option in the Print Directory dialog.

Select Print to Printer if you wish to send the information to the printer (hard copy) or Print to File 
if you wish to save the information in a file. In the latter case, a dialog will be displayed prompting you for 
a filename.

The Print Directory output contains the disk's volume label, one directory or filename per line, including 
the filename extension, the file size in bytes, the date and time the file was last modified, and the file's 
attributes. At the end of the listing, the total number of files, the total number of directories, the 
cumulative size of the files, and the free space remaining on the disk are also printed.

Note:    Because of a File Manager problem, the Print Directory command is only available from the 
WizManager menu when at least one file or directory is selected in File Manager's directory window. 



Print Search Results List

The Print Search Results List dialog allows you to print the listing of the selected files or to print
the listing of all the files in File Manager's Search Results window. The Search Results List can 
be sent to a printer (hard copy) or saved in a file.

The path of the files selected in File Manager is displayed at the top of the dialog with the number of 
selected files underneath.

You can choose to print the listing of only the selected files or the listing of all the files in the 
window by selecting the appropriate option in the Print Search Results List dialog.

Select Print to Printer if you wish to send the information to the printer (hard copy) or Print to File 
if you wish to save the information in a file. In the latter case, a dialog will be displayed prompting you for 
a filename.

The Print Search Results List output contains the disk's volume label, one directory or filename with its 
full path on two lines, including the filename extension, the file size in bytes, the date and time the file 
was last modified, and the file's attributes. At the end of the listing, the total number of files and the total 
number of directories are also printed.

Note:    Because of a File Manager problem, the Print Search List command is only available from the 
WizManager menu when at least one file or directory is selected in File Manager's Search Results 
window. 



Print Tree

The Print Tree dialog allows you to print the hierarchical directory structure of a disk or save 
this information in a file. The printing of the names of the files in each directory and the total 
size of each directory can optionally be included.

Select the appropriate drive from the drop down list.

Check Print Filenames in Directories if you wish to include the printing of the filenames in each 
directory.

Check Print Each Directory Size if you wish to include the printing of the total size of each 
directory.

Select Print to Printer if you wish to send the information to the printer (hard copy) or Print to File 
if you wish to save the information in a file. In the latter case, a dialog will be displayed prompting you for 
a filename.



Open Files

The Open Files dialog allows you to specify how the files selected in File Manager should be 
opened and displayed.

Specify which application should open the selected files:

Selecting Associated will open each file with its associated application.
Selecting Associated with File Extension will open all the files with the application 

associated with the specified extension. The extension entered cannot exceed 3 characters (not including
the optional period as first extension character).

Selecting the third option allows you to enter the path and filename of a specific 
application which should open all the files. Use the Browse button if you wish to browse through your 
directories and drives to find the appropriate application.

Specify in the Run group how the selected files should be displayed: Normal, Minimized, 
Maximized or Hidden.

Check Start Only One Application in the dialog if you want to start only one copy of the application
and display all the files within this application. Be aware that many applications are not able to display 
multiple files or generate an error message with this option checked. 



Info Menu Command

These commands are available in the WizManager menu, under the Info menu item.

Disk Info... 
System Info... 

See also
WizManager menu commands



Preferences Menu Command

Selecting the Preferences menu item in the WizManager menu opens the Preferences     dialog   which 
lets you customize WizManager.

See also
WizManager menu commands



Launch Menu Command

The commands available in the WizManager menu and in WizManager's popup menu, under the 
Launch menu item are the menu items set in the Customize Launch Menus dialog.

See also
WizManager menu commands



Customize Launch Menus Command

Selecting the Customize | Launch Menus menu item in the WizManager menu opens the Customize 
Launch Menus dialog. 

Customize Launch Menus allows you to set commands, programs or filenames which can be executed 
or opened when the corresponding customized menu item is selected under the Launch menu item. 

See also
WizManager menu commands



Print Directory Menu Command

Selecting the Print Directory menu item in the WizManager menu enables you to print a directory 
listing of the files in the active File Manager directory window or save this information in a file. The 
displayed Print Directory dialog allows you to print the listing of the selected files or to print the listing of 
all the files in the File Manager directory window.

Note:    Because of a File Manager problem, the Print Directory command is only available from the 
WizManager menu when at least one file or directory is selected in File Manager's directory window. 

See also
WizManager menu commands



Print Tree Menu Command

Selecting the Print Tree menu item in the WizManager menu enables you to print a selected disk's 
hierarchical directory structure or save this information in a file. The displayed Print Tree dialog allows 
you to include the printing of the names of the files in each directory and the total size of each directory.

See also
WizManager menu commands



Printer Setup Menu Command

Selecting the Printer Setup menu item in the WizManager menu opens a printer setup dialog which 
allows you to set printing options specific to your default printer.

A printer setup dialog can only be displayed if a printer driver has been installed. For information about 
installing a printer driver, see Installing a Printer Driver in your Windows manual.

See also
WizManager menu commands



Open Files Menu Command

Selecting the Open Files menu item in the WizManager menu opens the Open Files dialog which 
allows you to select how the selected file(s) in File Manager should be opened and displayed.

Open Files enables you to view the files or open files with a specified application, open files which don't 
have an association, open files without extension, and more.

The Open Files command is only available from the WizManager menu when at least one file is 
selected in File Manager's directory window.

See also
WizManager menu commands



View Files Menu Command

Selecting the View Files menu item in the WizManager menu starts the Viewer application set in 
Preferences and displays the contents of the files selected in File Manager.

The View Files command is only available from the WizManager menu when at least one file is selected
in File Manager's directory window.

See also
WizManager menu commands



DOS Prompt Menu Command

Selecting the DOS Prompt menu item in the WizManager menu starts a new DOS prompt (command 
line) session.

DOS Prompt executes the program named COMMAND.COM through a configuration file named 
DOSPRMPT.PIF. The latter file is automatically installed in your Windows directory when Windows is 
installed. DOSPRMPT.PIF controls several facets of the way COMMAND.COM is launched from this 
command. You can modify (or recreate if necessary) the file using the Windows application 
PIFEDIT.EXE. Refer to the "PIF Editor" chapter of your Windows User's Guide for detailed information 
on how to customize a PIF file.

A different PIF file can be used instead of DOSPRMPT.PIF. You can set your preferences by selecting 
the WizManager Preferences menu command or by typing PREF    in WizManager's Command Line 
Box.

See also
WizManager menu commands



Lock

Selecting the Lock menu item in the WizManager menu minimizes all running applications and locks 
Windows until you enter your password in the displayed Unlock dialog.

Lock lets you completely lock your system and restore it after typing a password you previously 
defined. This feature permits you to leave your station, keeping information confidential or secured until
you come back and the defined password is entered. 

For maximum confidentiality, during the locking process all applications are minimized leaving only an 
Enter Password dialog displayed. Applications running in the background which cannot run properly 
when minimized (for example, certain communication programs) are left untouched.

If you want to set or change your password, type the command PASSWORD in the Command Line 
Box or select Password in the Preferences dialog.

The Alt+Ctrl+Del (reboot) key combination can be disabled while your system is locked. For this feature
to work properly, the device vrbtd.386 has to be declared in the [386Enh] section of SYSTEM.INI and 
the option has to be set in the Preferences dialog.

See also
WizManager menu commands



Control Panel Menu Command

These commands are available in the WizManager menu, under the Control Panel menu item. 
Selecting a Control Panel command will start the corresponding Control Panel Option dialog.

Color
Date / Time
Desktop
Drivers
Fonts
International
Keyboard
Mouse
Ports
Printers
Sound
Network
386 Enhanced

See also
WizManager menu commands



Exit Menu Command

These commands are available in the WizManager menu, under the Exit menu item.

Exit Windows... 
Restart Windows... 
Reboot System... 

See also
WizManager menu commands



Buttonbar Menu Command

Selecting the Buttonbar menu item in the WizManager menu displays or hides the Buttonbar. A check 
mark is present at the left of the Buttonbar menu item when the Buttonbar is visible. 

See also
Customize Buttonbar menu command    
WizManager menu commands



Customize Buttonbar Menu Command

Selecting the Customize Buttonbar menu item from the WizManager menu opens the Customize 
Buttonbar dialog which allows you to add and remove buttons from the Buttonbar, set the button order 
in the Buttonbar, specify the number of buttons displayed and the number of buttons scrolled per scroll 
increment.

See also
Buttonbar menu command 
WizManager menu commands



About WizManager Menu Command

Selecting the About WizManager menu item from the WizManager menu opens the About dialog 
which displays information about WizManager's version number, Windows running mode, and memory 
usage. It also lists the different channels through which you can contact Mijenix (address, tel, fax, 
CompuServe, EMail, etc.). 

See also
WizManager menu commands



Help Menu Command

Selecting the Help menu item from the WizManager menu opens the WizManager help file and 
displays its help contents (index). From there it is possible to access any information either through the
logic of the different help items (jumps) or through the Search command. 

See also
WizManager menu commands



Tile Horizontally Menu Command

Selecting the Tile Horizontally menu item from the Window menu will arrange directory windows on 
top of each other    (horizontally) so that each window is visible and no windows overlap. 

If several directory windows are open, you may need to arrange the windows so that you can see them
all. Tiling the windows horizontally or vertically is a very useful feature which lets you navigate through 
the different windows with ease. When many windows are displayed, tiling horizontally or vertically 
becomes equivalent. In this situation, cascading the windows is oftentimes more efficient. 

With a very busy File Manager (many open windows), it is sometimes better to minimize all the 
windows and restore only the ones needed for a certain task, tiling them horizontally or vertically if 
necessary.      

See also
Menus Added to the Window menu    
WizManager menu commands    
Menu added to the Options menu 



Tile Vertically Menu Command

Selecting the Tile Vertically menu item from the Window menu will arrange the directory windows side 
by side (vertically) so that each window is visible and no windows overlap. 

If several directory windows are open, you may need to arrange the windows so that you can see them
all. Tiling the windows horizontally or vertically is a very useful feature which lets you navigate through 
the different windows with ease. When many windows are displayed, tiling horizontally or vertically 
becomes equivalent. In this situation, cascading the windows is oftentimes more efficient. 

With a very busy File Manager (many open windows), it is sometimes better to minimize all the 
windows and restore only the ones needed for a certain task, tiling them horizontally or vertically if 
necessary.      

See also
Menus Added to the Window menu    
WizManager menu commands    
Menu added to the Options menu 



Minimize Menu Command

Selecting the Minimize menu item from the Window menu will minimize all the directory windows to 
icons. 

With a very busy File Manager (many open windows), it is sometimes better to minimize all the 
windows and restore only the ones needed for a certain task, tiling them horizontally or vertically if 
necessary.      

See also
Menus Added to the Window menu    
WizManager menu commands    
Menu added to the Options menu 



Restore Menu Command

Selecting the Restore menu item from the Window menu will restore all the minimized directory 
windows to their previous size and location. 

See also
Menus Added to the Window menu    
WizManager menu commands    
Menu added to the Options menu 



Save Settings Now Menu Command

Selecting the Save Settings Now menu item from the Options menu will save the positions and views 
of all open File Manager directory windows.

Save Settings Now lets you immediately save the positions and views of open File Manager directory 
windows. When you restart File Manager, the open directory windows will be in the same positions and
have the same View menu settings as they had at the time you used this command. With the Save 
Settings Now command you don't have to set the Save Settings on Exit menu command and close File
Manager in order to keep the directory windows layout. It is saved at the time you select the Save 
Settings Now command.

NOTE:    Holding down the SHIFT key while selecting the Exit command from the File menu has the 
same effect as selecting the Save Settings Now command.

See also
WizManager menu commands 
Menus Added to the Window menu



Disk Info

When selecting the Disk Info menu item from the Window menu the specified drive is scanned and 
numerous information about disk usage and files statistics is retrieved. 

Disk Info displays:

Disk size
Space used by files
Free space left
Percentage of disk used
Average file size
Total number of files
Total number of directories
Smallest file size and path
Largest file size and path
Largest directory structure and path

NOTE: DISKINFO and File Manager display inaccurate file space usage of drives which are user 
space restricted network drives (allocated space). The used space displayed is the unavailable drive 
space added to the actual file space. The average file size is therefore inaccurate. This problem will be 
addressed with the next WizManager update.

See also
WizManager menu commands



System Info

Your system is scanned when selecting the System Info menu item from the Window menu and 
information about your computer and Windows configuration is displayed.

If you have questions about your computer and Windows configuration, System Info is a handy 
command to use. It instantly displays information about your system in a single dialog box. You are 
able to see at a glance how much memory you have available,    what your CPU, video type and 
resolution are, and if you have a coprocessor. It displays the system date and time, WizManager, DOS 
and Windows versions, whether you are connected to a network, and other critical information. 

See also
WizManager menu commands



Exit Windows

Selecting the Exit Windows menu item from the Window menu closes and ends all applications 
running in Windows and exits Windows.

Exit Windows lets you quickly close and terminate Windows. This command executes an orderly 
shutdown sequence of windows. A confirmation dialog is displayed before proceeding with the closing. 
This can be changed in the Preferences dialog.

During the process, any running application with unsaved changes will ask for confirmation before 
closing. If all applications agree to quit, the Windows session is terminated and control returns to DOS.

See also
WizMafager menu commands



Restart Windows

Selecting the Restart Windows menu item from the Window menu exits and restarts Windows.

Restart Windows executes an orderly shutdown sequence of windows, exits and restarts Windows. A 
confirmation dialog is displayed before proceeding with the restart. This can be changed in the 
Preferences dialog.

During the process, any running application with unsaved changes will ask for confirmation before 
closing. If all applications agree to quit, the Windows session is terminated and a new Windows 
session is created. The restart process is identical to completely exiting Windows and restarting it from 
the DOS prompt.    

A restart is necessary to activate any changes to your SYSTEM.INI file, and may also be used if you 
wish to restart the system with an altered WIN.INI file, for example.

See also
WizManager menu commands



Reboot System

Selecting the Reboot System menu item from the Window menu exits Windows and reboots (restarts)
your system.

Reboot System executes an orderly shutdown sequence of windows and completely restarts your 
computer. A confirmation dialog is displayed before proceeding with the reboot. This can be changed in
the Preferences dialog.

During the process, any running application with unsaved changes will ask for confirmation before 
closing. If all applications agree to quit, the Windows session is terminated and the system is restarted 
(cold reboot). The Reboot process is identical to turning the power off and back on or pressing the 
reset button of your computer.    

A reboot is necessary to activate any changes to your CONFIG.SYS file, and may also be used if you 
wish to restart the system with an altered AUTOEXEC.BAT file, for example.

See also
WizManager menu commands      



View Files

WizManager's File Viewer is a utility which lets you view the contents of a file or files without having to 
run the program that created them. The File Viewer engine provided with WizManager is built-into 
WizManager, is fully integrated and doesnt have to be launched separately (not a separate .EXE 
program). 

There are several ways to display a file with the File Viewer. You can:

Select the file(s) you wish to view in File Manager and then either click on the View Files button in
the Buttonbar or select View Files from the WizManager menu. You can also drag and drop the selected 
file(s) to the View Files button.

Or, start the File Viewer and then drag and drop the selected files on the File Viewer dialog or on 
the minimized File Viewer icon.

1. Once you have used File Viewer, you dont necessarily have to close the Viewer window. You can 
simply minimize it for later use. Activating the File Viewer again through the View Files menu or 
button or by drag and drop will automatically restore the File Viewer.

2. File Viewer will remember its location on the screen and its size. The next time you launch File 
Viewer, it will display itself the same way (location and size) you left it. This allows you to customize 
the exact position and size of File Viewer with respect to File Manager for example.

3. File Viewer will automatically detect the file format of the selected file and display its contents using 
its special viewer filters. File format filters are available for over 30 file types.

4. The File Viewer file list is cleared when File Viewer is launched to display new files. Hold the Shift 
key down while selecting the View Files menu or button if you wish to add new files to the file list.

See also:
File Viewer Toolbar and Commands    
File Format Filters    



Find Files

Start Find Files by selecting Find Files from the WizManager menu.

Find Files is a powerful file finder which allows you to retrieve a file or multiple files according to criteria 
you specify in the Find Files dialog. 

The Find Files dialog is expandable (select the More >>    button) to display more Search Options.

With Find Files, you can perform a file search even if you just know one word contained in the file or 
only know an approximate date when the file was created. 

File Finder also allows you to perform many other file management tasks such as finding all the space-
taking hog files (set a search condition on file size) or finding all the files recently created by users on a 
network server (set a search condition on file date).

The Find Files search process is performed using threads i.e. it is possible to let Find Files scan your 
disk(s) and continue to work in Windows. When Find Files is done, a Files Found dialog is displayed 
which lets you manage the retrieved files.

See also:
Search Options    
File Search Results    



Find Duplicates

Start Find Duplicates by selecting Find Duplicates from the WizManager menu.

Find Duplicates finds out all the duplicate files present on one or more drives, or on a path and helps 
you recover precious disk space. 

Multiple matching criteria can be specified. The Find Duplicates dialog is expandable (select the More 
>>    button) to display more Duplicates Search Options.

The Find Duplicates search process is performed using threads i.e. it is possible to let Find Duplicates 
scan your disk(s) and continue to work in Windows. When Find Duplicates is done, a Duplicates Found 
dialog is displayed which lets you manage the duplicate files found.

See also:
Duplicates Search Options    
Perform a Search for Duplicates
Duplicates Search Results    



Synchronize Directories

Synchronize Directories allows you to synchronize (update) the contents of two directories using 
various options. This feature is a must have utility if you are working with a portable computer or with 
multiple computers.

To perform a directory comparison:

1. Enter a directory path in the Directory 1 field. Use the corresponding Browse button if you wish to 
browse through your drives and directories to select a path, or select a previously entered path from 
the combo drop.

2. Enter a second directory path in the Directory 2 field. Use the corresponding Browse button if you 
wish to browse through your drives and directories to select a path, or select a previously entered 
path from the combo drop.

3. Select Compare.

Synchronize Directories reads both paths and displays a Synchronize Directories (Results Dialog) 
dialog which lets you specify how the synchronization / update should be performed.

See also:
Synchronize Directories (Results Dialog)    



Directories Size Browser

Directories Size Browser is a utility which lets you find out what exactly the size of directories are, with
or without their subdirectories structure. Directories Size Browser also enables you to tag/select 
directories and structures which correspond to conditions you can specify, and print all this information 
to your printer or to a file.

To browse the size of directories:

1. Select the directories in File Manager. You can also select a drive (top of the directory tree) to 
have size information about every directory on that drive.

2. Select the Directories Size Browser menu item from the WizManager menu.

3. WizManager will perform a search through the selected directories to determine the size of each 
directory and once done, a results dialog will be displayed with a directory structure in a list similar to File 
Manager's directory tree.

The left side of the list contains the folders of the directories chosen in File Manager. The first column of
numbers is the size of each directory (the size of all the files in the directory, not counting the possible 
subdirectories). The second column indicates the size of the directory including all of its subdirectories. 
A number in this second column are only displayed if a directory contains subdirectories.

A directory folder with a '+' drawn in it indicates that the directory contains subdirectories. Double-click 
on the folder to expand it and display its structure. You can also select the Expand All button to have the
entire directory expand down to the end of its structure.

It is possible to tag directories which fulfill certain size conditions. To do so, select the condition from the
Tag branch/dir size combo drop and enter a size in byte in the displayed box(es). The size should be a 
number without punctuation (no comma (,), period (.), etc.). Once done, click on the Update button. 
Directories matching the conditions will immediately be recognizable by their red folders.

You can print the contents of the directory tree to your printer or to a file by selecting the Print button.



Set Files Date/Time

Set Files Date/Time lets you change the date and time of the files you select in File Manager.

In the displayed dialog, set the new Date and Time, making sure that the entered values are within the 
range of each data field.

Once the appropriate Time and Date are entered, select the Ok buttons to have WizManager update 
the files selected in File Manager.

Note:    Only the Date and Time of files can be modified. This feature will not modify the Date or Time of 
directories.



Print Directory

Print Directory allows you to print the listing of the selected files or to print the listing of all the files in 
the File Manager directory window. The directory listing can be sent to a printer (hard copy) or saved to 
a file.

Select Print | Print Directory from the WizManager menu to display the Print Directory dialog 
which lets you set the specific options, and print the directory listing.



Print Tree

Print Tree allows you to print the hierarchical directory structure of a disk or save this information to a 
file. The printing of the names of the files in each directory and the total size of each directory can 
optionally be included.

Select Print | Print Tree from the WizManager menu to display the Print Tree dialog which lets 
you specify which drive's tree should be printed, set specific options, and print the tree information.



Disk Info

Disk Info allows you to retrieve and display important information about your drives. 

Select Info | Disk Info from the WizManager menu to display the Disk Information dialog and all 
the data about your drive(s).



System Info

System Info allows you to retrieve and display important information about your system.

Select Info | System Info from the WizManager menu to display the System Information dialog 
and all the data about your system.



Exit, Restart, Reboot

Exit Window, Restart Windows and Reboot System can be selected from the Exit menu in the 
WizManager menu.

Exit Windows executes an orderly shutdown sequence of windows and then exits Windows.

Restart Windows executes an orderly shutdown sequence of windows before automatically restarting 
Windows.

Reboot System executes an orderly shutdown sequence of windows before shutting down the system 
and restarting it (cold reboot).



New + Cascade or Tile Horizontally or Tile Vertically

Selecting the New + Cascade menu item from the Window menu will automatically perform two 
actions: it will open a new directory window and then cascade all the directory windows in File Manager.

The New + Tile Horizontally and New + Tile Vertically are similar commands but instead of cascading 
the directory windows, they are tiled horizontally respectively vertically in File Manager.



File Viewer Formats/Filters

WizManager's File Viewer supports many file formats. File Viewer always tries to determine if it can 
display a file in one of its special viewers.    If there is no special viewer for the file, or if the format 
is not recognized, the file will be shown with the Hex viewer. Use the Viewer button to change the 
displayed format to ASCII if necessary.

The currently available file format filters are the following:

ASCII / Text
Hex
Microsoft Word
Microsoft Word for Windows
Windows Write
WordPerfect
WordPerfect for Windows
Ami Pro
Q&A Write
Q&A Write for Windows
Microsoft Works Word Processor
Microsoft Works Word Processor for Windows
DBase
FoxPro
Paradox
Paradox for Windows
Microsoft Works Database
Microsoft Works Database for Windows
Excel
Lotus 123
Lotus WK3
Quattro 
Quattro Pro
Quattro Pro for Windows
Windows Metafile
Windows Sound Files (WAV)
BMP
ICO
PCX
GIF
TIF
ZIP
LZH

Note:    Some automatic file selections are based on the file extension. Passing a file with a non-
standard file extension may keep automatic selection from determining the proper file format.

See also:
File Viewer Toolbar and Commands    



File Viewer Toolbar and Commands

The File Viewer Toolbar allows you to quickly perform tasks related to the displayed file:

Button Action
____________________________________________________________________________

Open Lets you browse through your drives and directories to select a file to display.

Close Closes the currently displayed file.

File List Displays a list of the files which were selected to be viewed. This allows you to quickly 
jump to another file.

Prev, Next Allow you to display the previous or the next file. The first file of the list is displayed once 
the end of the file list is reached and the Next button is pressed. The last file of the list is 
displayed when at the top of the file list and the Prev button is pressed. The Prev and 
Next buttons will not be active unless the File List contains more than one file.

Find Allows you to perform a text search within a file. This option is available for all file formats
except picture/bitmap files and sound files. For Hex files, the hex value of the string to 
search has to be entered, not a string.
Note: The Find feature only works properly if the font used to display the file is a non-
proportional font.

Launch Starts the displayed file using its associated application. An error message is displayed if 
no association exists.

Print Prints the contents of the displayed file using its associated application. An error message
is displayed if no association exists.

Edit, Play Lets you edit the displayed file using the text editor associated with the TXT extension 
(Notepad by default). This option is only available when a file is displayed using the ASCII
/ Text or Hex file filters. The Edit button becomes a Play button when the file to display is 
a sound file (.WAV). Selecting the Play button will play the sound file IF an appropriate 
sound driver is installed in your system, otherwise the sound file is displayed with the 
HEX viewer.

Viewer Lets you select to display the current file in ASCII or Hex instead of the automatic Viewer 
filter choice.

Font Allows you to set the font and font size used to display files.
Notes:    The Find feature only works properly if the font used to display the file is a non-
proportional font. The .ZIP and .LHA viewers may encounter problems if the default font 
used is a non-proportional font.

Help Invokes the File Viewer help topic.

Done Closes the File Viewer.

See also:
File Format Filters    



Search Options

Before performing a search for files, you must verify that the search criteria are set according to your 
search needs. Be aware that every additional condition you specify will narrow the number of files 
found.    Important: It is not necessary to specify every condition to perform a search. 

Here are the different search options and their meaning:

Option Description
____________________________________________________________________________

Find Files Enter the filename of the file you are looking for in this field (wildcards are allowed). If you
don't know or remember the name of the file, leave the default [All Files] as it will ignore 
any condition on the name of the file.

With text If you wish to retrieve a file or files which contain a specific string, enter the text in this 
field, or leave the box blank if you wish to ignore this condition. 
Note:    A file search is significantly slowed down if a search string is specified as the 
search procedure has to scan every file's contents during the search.

Search Specify either a search path or select one or more drives on which the search should be 
performed.

Attributes This set of check boxes enables you to limit the search to files which must have at least 
one of the checked attributes. Many files do not have any attributes, so make sure that 
the Without Attributes check box is checked if you are making a global search.

Date The date condition lets you specify a search condition based on the file(s) creation date. 
Select the condition from the Date combo drop and then enter a date or date range. The 
date format is mm/dd/yy    (month/day/year).

Time The time condition lets you specify a search condition based on the file(s) creation time. 
Select the condition from the Time combo drop and then enter a time or time range. The 
time format is hh:mm    (hour/minutes). Valid hours must be between 0-23 and minutes 
between 0-59.

Size The size condition lets you specify a search condition based on the file(s) size. Select the
condition from the Size combo drop and then enter a size or size range. The size is in 
byes and must be a numerical value without punctuation (no comma (,), period (.) or 
other characters).

See also:
File Search Results
Find Files    



Perform a File Search

To perform a search:

1. Enter a filename in the Find Files field (wildcards are allowed) or leave the default [All Files]. 

2. A search can be performed after specifying a path or selecting a drive or multiple drives.

3. Additional search conditions can be specified regarding file attributes, date, time and size. The date,
time and size constraints can be particularized to match the type of search you wish to perform. 
Select an appropriate option from their combo drop lists and then enter the applicable data in the 
fields automatically displayed at the right.

The constraints specified are automatically saved and made available in subsequent search sessions.

The Find Files search process is performed using threads i.e. it is possible to let Find Files scan your 
disk(s) and continue to work in Windows. When Find Files is done, a Files Found dialog is displayed 
which lets you manage the retrieved files.

Note:    A large number of files on your drive(s) do not have any file attribute set. It is therefore important
to include (check) the Without Attributes in your search if you wish to have Find Files scan these files.

See also:
Find Files
Search Options
File Search Results    



File Search Results

If files matching the search criteria are found, Find Files will display a Files Found dialog listing all the 
matching files. 

Each file is presented with the following information:

File Icon. 
File Size.
File Date and Time.
File Attribute.
File Path and Name.

The size of the icon or the presence of icons in the file list can be customized in the Preferences dialog.

The file list in the Files Found dialog can be sorted by file name, file extension, file size, file date, file 
time or file attributes.

You can select files in the Files Found file list by clicking on them or by using the Select buttons. Select 
by Mask lets you select files which match a specific filename and/or file extension mask (wildcards can 
be used). Hold the Shift key down when using the selection buttons if you wish to add the file selection 
to the currently selected files.

If you wish to display only the files you selected in the file list, switch the radio button from Display All 
files to Display Selected files.

Several file management functions are available through the Files Found Toolbar. Select first the files 
you wish to work on and then either click on a command button or drag and drop the selected files onto 
a Toolbar button. You can also launch a file by double-clicking on it in the file list.

Note:    The Files Found file list allows you to drag and drop files to programs which are drag and drop 
clients (which accept dropped files), like Program Manager for example.

See also:
Find Files
Search Options    



Duplicates Search Options

Before performing a search for duplicate files, you must verify that the search criteria are set according 
to your search needs. Be aware that every additional condition you specify will narrow the number of 
files found.    Important: It is not necessary to specify every condition to perform a search for 
duplicates. 

Here are the different search options and their meaning:

Option Description
____________________________________________________________________________

Find Files Enter the filename of the file you are looking for in this field (wildcards are allowed). If you
wish to scan all the files, leave the default [All Files] as it will ignore any condition on the 
name of the duplicate files to be found.

With text If you wish to retrieve duplicate files which contain a specific string, enter the text in this 
field, or leave the box blank if you wish to ignore this condition. 
Note:    A search for duplicates is significantly slowed down if a search string is specified 
as the search procedure has to scan every file's contents during the search.

Search Specify either a search path or select one or more drives on which the search    for 
duplicates should be performed.

Match by Specify how the duplicate files should match i.e. by file name, file size, file date, file time 
AND/OR file CRC (a CRC check verifies that the contents of the duplicate files are 
exactly the same).

Attributes This set of check boxes enables you to limit the duplicates search to files which must 
have at least one of the checked attributes. Many files do not have any attributes, so 
make sure that the Without Attributes check box is checked if you are making a global 
search for duplicates.

Date The date condition lets you specify a search condition based on the files creation date. 
Select the condition from the Date combo drop and then enter a date or date range. The 
date format is mm/dd/yy    (month/day/year).

Time The time condition lets you specify a search condition based on the file(s) creation time. 
Select the condition from the Time combo drop and then enter a time or time range. The 
time format is hh:mm    (hour/minutes). Valid hours must be between 0-23 and minutes 
between 0-59.

Size The size condition lets you specify a search condition based on the file(s) size. Select the
condition from the Size combo drop and then enter a size or size range. The size is in 
byes and must be a numerical value without punctuation (no comma (,), period (.) or 
other characters).

See also:
Find Duplicates
Perform a Search for Duplicates    
Duplicates Search Results    



Perform a Search for Duplicates

To perform a search for duplicates:

1. Enter a filename in the Find Files field (wildcards allowed) or leave the default [All Files]. 

2. A search for duplicates can be performed after specifying a path or selecting a drive or multiple 
drives. 

3. Specify the criteria which determines under which conditions files are duplicates by selecting 
(checking) the appropriate options in Match by.

4. Additional search conditions can be specified regarding file attributes, date, time and size. The date,
time and size constraints can be particularized to match the type of search you wish to perform. 
Select an appropriate option from their combo drop lists and then enter the applicable data in the 
fields automatically displayed at the right.

The constraints specified are automatically saved and made available in subsequent search sessions.

The Find Duplicates search process is performed using threads i.e. it is possible to let Find Duplicates 
scan your disk(s) and continue to work in Windows. When Find Duplicates is done, a Duplicates Found 
dialog is displayed which lets you manage the duplicate files found.

Note:    A large number of files on your drive(s) do not have any file attribute set. It is therefore important
to include (check) the Without Attributes in your search for duplicates if you wish to have Find 
Duplicates consider these files.

See also:
Find Duplicates
Duplicates Search Results
Duplicates Search Options    



Duplicates Search Results

If files matching the duplicates search criteria are found, Find Duplicates will display a Duplicates Found
dialog listing all the matching files. Matching files are grouped together, each group being separated by 
a light gray line from the next group.

Each file is presented with the following information:

File Icon.
File Size.
File Date and Time.
File Attribute.
File Path and Name.

The size of the icon or the presence of icons in the file list can be customized in the Preferences dialog.

The file list in the Duplicates Found dialog can be sorted by file name, file extension, file size, file date, 
file time or file attributes.

The duplicates files are sorted by file name in the Duplicates Found file list. Duplicates sets are 
separated by a light gray line.

The word duplicates is used in a broader meaning than its real definition i.e. in Find Duplicates, 
duplicates are the multiple existence of files on the specified drive(s) or path (not limited to two 
instances of a file). A file may exist in more than two copies and Find Duplicates will display all the 
matches according to the constraints set in Find Duplicates.

You can select files in the Duplicates Found file list by clicking on them or by using the Tag and /or 
Select buttons. Select by Mask lets you select files which match a specific filename and/or file 
extension mask (wildcards can be used). Hold the Shift key down when using the Tag or Select buttons 
if you wish to add the selection to the currently selected files.

If duplicates within a set of duplicates have the same file size, Tagging the Smaller or the Larger file 
will not select any file within the duplicates set.

If duplicates within a set of duplicates have the same date stamp, Tagging the Older or the Newer file 
will not select any file within the duplicates set.

Several file management functions are available through the File Found Toolbar. Select first the files 
you wish to work on and then either click on a command button or drag and drop the selected files onto 
a Toolbar button. You can also launch a file by double-clicking on it in the file list.

Note:    The Duplicates Found file list allows you to drag and drop files to programs which are drag and 
drop clients (which accept dropped files), like Program Manager for example.

See also:
Find Duplicates
Perform a Search for Duplicates
Duplicates Search Options    



Synchronize Directories (Results Dialog)

The Synchronize Directories dialog displays the contents of the two specified paths in two file lists, the 
respective paths being displayed above each list. 

Only one file list is active at any one time. The active list has the file information displayed in dark 
characters whereas the inactive file list has its information displayed with light characters. The Switch 
button in the Directory Comparison Toolbar also indicates which file list is currently active. Use this 
switch button to switch the activation to the other file list.

Each file in the lists is presented with the following information:

File Icon. 
File Size.
File Date and Time.
File Attribute.
File Path and Name.

The size of the icon or the presence of icons in the file list can be customized in the Preferences dialog.

The file lists can be sorted by file name, file extension, file size, file date, file time or file attributes.

You can select files in the file list by clicking on them or by using the Tag and/or the Select buttons. 
Select by Mask lets you select files which match a specific filename and/or file extension mask 
(wildcards can be used). Hold the Shift key down when using the Tag or Select buttons if you wish to 
add the selection to the currently selected files.

The tagging follows the matching conditions specified in Match by. File CRC determines that the file 
contents must be exactly the same.

By default, the file list are Name-Aligned (the file lists are aligned by corresponding files/filenames). 
However, you can also chose to have the lists displayed in a more compact way by selecting the 
Compact option in the dialog.

If you wish to display only the files you selected in the file list, switch the radio button from Display All 
files to Display Selected files.

Several file management functions are available through the Directory Comparison Toolbar. Select first
the files you wish to work on and then either click on a command button or drag and drop the selected 
files onto a Toolbar button. 

You can also drag and drop the selected files onto the other file list to copy the selection from one list to
the other. 

It is possible to launch a file by simply double-clicking on it in the file list. 

The file list allows you to drag and drop files to programs which are drag and drop clients (which accept 
dropped files), like Program Manager for example.



New Zip,    Create/Open Zip file

The New Zip command lets you create a new Zip file.

In the Create/Open Zip file dialog, enter a path and filename or browse through the directories to 
find a file, then click Ok.

Check the Follow with "Add Files" dialog check box if you wish to automatically continue by 
adding files to the newly created Zip file.

See also:
Zip, UnZip and Open Zip Files 



UnZip/Extract

UnZip/Extract Files allows you to extract files from a Zip file. Several options are available to you to 
perform this task.

Option Description
____________________________________________________________________________

File Specify if you want only the selected files to be extracted, or all the 
files, or an entered file list. A file list is a sequence of filenames with 
extensions. Separate these file specifications with one space with no 
spaces at the beginning or at the end of the list. Each specification 
can include the standard DOS wildcards.

Action The Action option allows you to specify how the UnZip/Extract files 
process should be performed. 'Extract' will extract and expand the 
selected file(s) without conditions.    'Freshen' will only extract the 
files in the Zip file which already exist in the target directory and 
which have been modified more recently than the version in the 
target directory. 'Update' is similar to freshen, but it will also extract 
files to the target directory which do not yet exist in the target 
directory.    'Test' will perform an extraction, but no files will be written 
in the target directory (used to verify that a Zip file extracts without 
errors).

Overwrite existing files Check this option if you wish to overwrite without warnings the files 
with the same filename in the target directory.

Extract empty directories Check this option if you wish to extract directories in the Zip file 
which do not contain files to the target directory (create empty 
directories structure in the target directory).

Decrypt, Password Check the Decrypt check box if files to be extracted have been 
encrypted in the Zip file and need a password to be extracted. Enter 
the correct password in the corresponding edit filed.

Note that each file in a ZIP file can have a separate encryption code 
(password). Use a separate Extract operation (or Freshen or Update)
for each file (or group of files) with a different password. 

The decryption password can contain up to 65 characters and is 
case sensitive. Numbers and spaces can be part of a password. 

IMPORTANT: The extraction of an encrypted file is only possible if 
the correct password is specified in the UnZip/Extract operation. 

Create program group and 
icons Program items (icons) can be automatically created in a specified 

group during the extraction process in Program Manager (or 
compatible shell). Check this box if you wish to automatically create 
program items. Specify also a group name and the maximum 
number of icons which should be created.



See also:
Zip, UnZip and Open Zip Files 



Zip/Add Files

Zip/Add Files allows you to add files to a Zip file. Several options are available to you to perform this 
task.

Option Description
____________________________________________________________________________

Action The Action option allows you to specify how the Zip/Add files process 
should be performed. 'Add' will add the selected file(s) without 
conditions. 'Move' will do the same and delete the original file after 
storing it in the Zip file. 'Freshen' will only add the files in the Zip file 
which already exist in the Zip file and which have been modified more 
recently than the version in the Zip file. 'Update' is similar to freshen, 
but it will also add files into the Zip file which do not yet exist in the Zip 
file.

Compression This option allows you to set the rate of compression from Extra High 
compression to a simple storage of the files where no compression is 
performed. Note that increasing the compression factor will affect the 
speed at which the compression process is performed, the higher the 
compression rate, the slower the process becomes.

Multiple disk spanning This option is only available if the Zip file is located on a removable 
disk.    

Multiple disk spanning allows you to compress files onto diskettes and 
create a Zip file larger than what a single diskette can hold. Once the 
first disk is full, Zip/UnZip will prompt you with the second disk and so 
on. You can chose from the Multiple disk spanning combo drop to have
Zip/UnZip wipe the diskettes' contents or format the diskettes before 
writing the Zip file to them, during the multiple disk spanning process.

Recurse Subdirectories Check the Recurse Subdirectories check box if you wish Zip/Add to 
recursively traverse all subdirectories underneath the specified 
directory and store in the ZIP file all the files and directories found.    
This provides an easy way to zip (and backup) all files in a branch of a 
directory tree.

Include directory 
path(s) in ZIP Check the Include directory path(s) in ZIP check box if you wish to 

store not only the names of the files added to the ZIP file, but also the 
directory information (path). If this option is checked, the full path of 
each file relative to the current path, minus the drive letter, will be 
stored in the ZIP file.

Ignore empty directories Check the Ignore empty directories check box if you wish to ignore any
directory that is found empty i.e. empty directories will not be stored in 
the ZIP file.

Include SYS/HIDDEN files Check the Include SYS/HIDDEN files check box if you wish to add files
which have the HIDDEN and/or SYSTEM attribute to the ZIP file

Include volume name Check the Include volume name check box if you wish that the ZIP file 



also stores the volume label of the drive containing the selected files.

Store names in upper case Check the Store names in upper case check box if you wish all file 
names to be stored in capital letters in the ZIP file.

Set ZIP file date to most 
recent file in ZIP Check the Set ZIP file date to most recent file in ZIP check box if you 

wish the ZIP file itself to be set to the date and time of the latest (most 
recent) file stored in the ZIP file.

Don't compress suffixes Check the Don't compress suffixes check box to indicate that any file 
whose file extension matches one of the extensions entered in the edit 
field (next to the check box) will not be compressed, but will simply be 
stored in the ZIP file. This is useful as it can accelerate the 
compression process by ignoring files that may already be 
compressed.

The list of file extensions to which each file will be compared should contain a list of extensions each 
separated by a colon (:) or semicolon (;).    For example, if the list is  
  .TIF;.JPG;.WAV    , then any files ending with .TIF, .JPG, or .WAV will 
not be compressed before being added to the ZIP file.

Encrypt, Password Check the Encrypt check box if you wish to protect the access and 
encrypt the contents of the files being stored in the ZIP file. If this 
option is checked, each file will be encrypted using the provided 
password before being added to the ZIP file. 

This file encryption feature can be very useful if you wish to ensure the 
confidentiality of the contents of the files in a ZIP file or to limit the 
access to a file or group of files (within a ZIP file) to only a selected 
group of users who know the encryption password.

Note that each file in a ZIP file can have a separate encryption code 
(password). Use a separate Add (or Freshen or Update) operation for 
each file (or group of files) that you want encrypted with a particular 
code. 

The encryption password can contain up to 65 characters and is case 
sensitive. Numbers and spaces can be part of a password. 

IMPORTANT: The extraction of an encrypted file is only possible if the 
correct password is specified in the UnZip/Extract operation. Therefore,
make sure that you take all the necessary precautions so that the 
encryption password or passwords are not "lost".

See also:
Zip, UnZip and Open Zip Files 



Notes (in Zip File)

Through the Notes dialog, you can read the comments associated with a Zip file or add your own 
comments into the Zip file.

Enter or modify the text in the edit box. Use Alt+Enter to create a new paragraph.

Once done, select the Ok button to store the information into the Zip file.

See also:
Zip, UnZip and Open Zip Files 



Test Zip File

The Test feature is useful to determine that files can be properly extracted (extracted without errors) 
from a Zip file without actually writing the extracted files to the disk. You may want to use this feature 
before distributing a Zip file or making it available on a network or for download.

See also:
Zip, UnZip and Open Zip Files 



Fix Zip File

The Fix Zip file feature allows you to repair a damaged Zip file.

There are two possible steps in the reconstruction of a damaged Zip file:

Repair the internal file header will attempt to reconstruct/repair the internal Zip header of the Zip file if it 
finds some of the files missing.

Rebuild the Zip file structure will attempt to fix a damaged Zip file by trying to redetermine the 
compressed size of each file in the Zip file.

WARNING: Repair a Zip file only if it cannot extract its files properly. Try to repair the internal Zip
header first and if not successful, select to rebuild the Zip file structure.    Success depends on 
the kind of damage existing in the Zip file and cannot be guaranteed.

See also:
Zip, UnZip and Open Zip Files 



New / Modify Launchbar Button

The New or Modify Launchbar Button dialog allows you to specify the different parameters of the 
Launchbar button.

Description: Enter the description of the button as you wish it to appear in the small 
description window under the button in File Manager. Entering a description is 
optional; if no menu text is specified, then the Command Line program or 
filename is displayed as the description

Command Line: Enter the command to execute, the program to start or the file to open. You can
select the Browse button to browse through your directories and drives to 
select a file. 

Working Directory: Enter the path of the directory which should be the working directory when the 
command specified in the Command Line is executed. Entering the working 
directory is optional.

Icon: By default, WizManager will automatically select the button icon as the first icon
in the program entered in the Command Line (or the associated application of a
file). However, you can modify the icon used for the button by selecting the 
Change Icon button.
 

Run: This option lets you specify how the application or file declared in the 
Command Line should be launched: Normal, Minimized, Maximized or Hidden.

See also:
Customize Launchbar    
Change Icon



Change Launchbar Button Icon

The Change Icon dialog lets you specify which icon should be displayed in the button.

Specify the path and filename of the file containing the icon you want to select in the File Name 
field, or use the Browse button to select a file.

Select the desired icon from the Current Icon list, and click Ok.

See also:
Customize Launchbar    
Modify Launchbar Button    



vrbtd.386

The vrbtd.386 virtual device is used while a system has been locked with the WizManager Lock feature 
to prevent a system reboot with the Alt+Ctrl+Del key combination.

vrbtd.386 is copied to your WizManager directory during the installation process of WizManager. 
However, the device is not automatically declared in the [386Enh] section of SYSTEM.INI.

To have the Lock option "Disable Alt+Ctrl+Del' work properly, you have to declare vrbtd.386 in your 
SYSTEM.INI file.    If the WizManager directory is C:\WIZMGR\    then the declaration in SYSTEM.INI 
under the [386Enh] section should be:

[386Enh]
Device=c:\wizmgr\vrbtd.386

Save the modification and restart Windows for the changes to take place.



Zip, UnZip, Open Zip File

WizManager's Zip/UnZip utility is a powerful tool which lets you compress or expand files. With 
Zip/UnZip you have the ability to read, test, fix, create, modify and write ZIP files, without having to 
"shell" to a DOS session. WizManager's Zip/UnZip is fully compatible with the latest version (2.04G) of 
PKZIP from PKWare, Inc., and even recognizes and decompresses earlier versions (1.x) and self-
extracting ZIP files (EXE). Because WizManager's Zip/UnZip has its own built-in ZIP encoding and 
decoding logic, PKZIP and PKUNZIP are not used, and need not even be present on the system.

To Zip (compress) files:

1. Select the files you wish to compress in File Manager.
2. Select Zip Files from the WizManager menu.
3. Enter a new Zip filename or chose an existing one in the displayed dialog and select Ok. A dialog 
presenting compression options will be presented. Select the desired options and hit Ok. Your files will 
automatically be compressed into the Zip file. The contents of the Zip file will be displayed in a list in the 
Zip/UnZip dialog.

To UnZip (expand) a file:

1. Select the .ZIP file you wish to extract the files from in File Manager.
2. Select UnZip File from the WizManager menu.
3. Select a directory to which the files will be extracted, chose the options you wish UnZip to 
perform, then select Ok and the files will automatically be expanding in the target directory.

To Open a .ZIP or self-extracting .EXE file:

1. Select the .ZIP or self-extracting .EXE file in File Manager.
2. Select Open Zip File from the WizManager menu.
3. The contents of the file will be displayed in the Zip/UnZip dialog. Use the Zip/UnZip Toolbar to 

perform any task on the file.

Zip / UnZip Toolbar and Commands:

Close Closes the currently displayed Zip file.
New Zip Allows you to create a new Zip file.
Open Opens an existing Zip file.
UnZip/Extract Expands files from a Zip file.
Zip/Add Files Compresses files into a Zip file.
Delete Removes the selected files from the Zip file.
View Displays the contents of the selected file.
Select All Selects all the files in the Zip file.
Notes Allows you to view or put comments into the Zip file.
Test Performs integrity tests on the Zip file.
Fix Repairs a damaged Zip file.
Help Invokes the Zip/UnZip help topic.
Done Closes the Zip/UnZip dialog



There are two ways to scroll the Buttonbar or the Launchbar (the 'bar'):
Use the left and right scroll buttons located at the left side of the 'bar'.
Or click with the right mouse button on any button of the 'bar'. The 'bar' will scroll the buttons by 

page until it reaches the last button and then scroll back.

During the scrolling process, the 'bar' scrolls and displays as many new buttons as your video resolution
permits (button page) until the 'bar' reaches the last set of buttons.    If you wish to change the number 
of buttons scrolled, select the Customize | Buttonbar or Customize | Launchbar command from the 
WizManager menu and specify your preferences.



To quickly understand each button's command, a small button information window is displayed 
underneath each button when the mouse cursor is positioned over a buttons. As long as you stay with 
the mouse cursor over the buttons limit, the button information window will continue to be updated and 
displayed. You can scroll the Buttonbar or the Launchbar with the right mouse button to display the next
page(s) of buttons. The automatic display of the info window can be disabled in the Preferences dialog.

If the Display Info Window is disabled you can still show the info window by holding down the SHIFT 
key while you click with the left mouse button on any button. The same small window showing the 
command's name will be displayed under the button. You can then release the SHIFT key and the 
mouse button and move the mouse over the next buttons to get the information. 

When the button you were looking for is found, simply select it with the left mouse button without 
worrying about the little help window. It will automatically disappear when the command is executed.



To customize the Buttonbar, select the Customize | Buttonbar command from the WizManager menu. 
A duplicate of the Buttonbar will be displayed. Select a button in the Buttonbar whose relative position in
the Buttonbar you wish to change and drag it to its new location. Repeat with other Buttonbar buttons 
until you are satisfied. If you wish to reset the entire Buttonbar to its default setting, select the Reset 
button. 

You can also add buttons to the Buttonbar by dragging new buttons from the "additional Buttons" bar. In
the same way, you can remove buttons from the Buttonbar by dragging them from the Buttonbar to the 
"Additional Buttons" bar.

The number of buttons displayed and the increment per scroll (number of buttons scrolled each time) 
can also be set in the Customize Buttonbar dialog.



To activate the Command Line Box either:
Click with the left mouse button in the edit field,
Or press Alt+BackSpace.

To return to File Manager directory window either:
Click on a directory or file in the directory tree or directory window, 
Or press Alt+Enter.

You can have the Command Line Box active and ready at File Manager's startup by selecting this 
option in the Preferences dialog selected from WizManager's menu.



The current Command Line Box drive and directory is displayed above the edit field. This current 
directory is independent of File Manager's directory windows. The startup drive and directory can be 
defined in WizManager Preferences.

Quick outputs from certain commands like PATH, DISKFREE, etc., are displayed next to the 
Command Line Box current directory. 

Error messages are also displayed next to the current directory information, in square brackets [...].    
The beep on error feature can be turned on or off in WizManager Preferences.



There are over 100 commands available within WizManager, like COPY, DEL, RENAME, ATTRIB, 
MEM, etc. Most of the WizManager commands accept the same parameters as their DOS equivalent 
commands and display similar information or confirmation dialogs as their equivalent commands in File 
manager.

You can also launch any application by typing its path (if necessary) and filename. 

You can open a file by entering its name. The associated application (if set) will be started and your file 
displayed.



You can call any command previously entered in the Command Line Box (command history) by:
Selecting the command from the drop down list,
or using the UP and DOWN keys.

The last 15 commands entered in the Command Line Box are automatically saved and are available in 
the command history the next time File Manager and WizManager are started.



You can press the ESC key (Escape key) at any time to interrupt a WizManager command.



By default, The ' ; ' (semi-colon) character symbol (without the quotes) represents in WizManager 
commands the path of the File Manager active directory window. 

This shortcut is very useful, for it allows you to easily work on the displayed files without specifying the 
path to the File Manager directory window. 

For example, if you want to copy all the files with the DOC extension from the File Manager 
directory window into the current WizManager directory, type: 

copy ;*.doc           (or    copy ;\*.doc    if you feel more comfortable keeping a backslash (\) 
between the ; and the filename). 

The ; can also be used as a target directory as in the command: 

move report.txt ;   (or    move report.txt \;). 

The path shortcut symbol can be changed in the Preferences      dialog.



DOS internal commands (COMMAND.COM commands) and external commands can be executed 
by entering a ' = ' (without the quotes) in front of the command, like =COPY,    =DEL or =MEM .



If any WizManager command has the same name as another external command or if you wish to 
execute a DOS command, type a ' = '    (without the quotes) in front of the command to execute the 
external command. For example,    =MEM will execute the DOS MEM command (instead of 
WizManager's MEM command).



Use the customizable Launch menus to place your frequently used commands or applications. They 
will then be only a click away, fast and easily accessible.



Press the right mouse button anywhere on File Manager and a popup menu will be displayed, listing 
all the currently active applications in Windows and enabling you to quickly switch to any of them. You 
can also minimize or restore all the applications, or close any of them (hold the Ctrl key down while 
selecting the application from the list). In addition, with the popup menu you can access your Launch 
menus and file commands such as Copy, Move, Delete, etc.    Select the Preferences command from 
the WizManager menu to customize the popup menu.



Quickly get your system information or disk(s) information by selecting Info in the WizManager 
menu.



A 'smart' association is integrated: Select Open Files from the WizManager menu. With Open Files 
you can open ALL (more than one at a time) the files selected in File Manager. 

In the displayed dialog box you can either view or open the files according to their associations 
(extensions), according to a specified association (for example, program associated with the TXT 
extension), or a specified program name (Browse to find the application path, or enter it directly). All the 
files can also be sent to the same application. 



Select the Print Directory command from the WizManager menu. With Print Directory you can print the
displayed File Manager directory listing or save it to a file. 

Print Directory lets you either print the list of the files selected in File Manager or the entire directory 
listing. WizManager also prints Search Result lists. 



Select the Print Tree command from the WizManager menu. You can specify in the dialog box that you 
want all the filenames in each directory printed with the disk directory structure. You can also select to 
have the size of each directory printed next to the directory name so that you can identify which 
directory is a 'hog' and make some room for your new file(s).    Print Tree can send the tree listing either 
to a printer or to a file.



Use the Lock command accessible from the WizManager menu. Your system can be safely locked and 
restored after typing a user defined password. This feature permits you to leave your station, keeping 
information confidential and secure until you return and enter your personal password.



The number of buttons displayed in the Buttonbar or Launchbar and the increment per scroll (number of
buttons scrolled each time) can be adjusted.    Select the Customize | Buttonbar or Customize | 
Launchbar command from the WizManager menu to set these preferences.



Fast Access Buttonbar
The Fast Access Buttonbar is a long awaited feature for File Manager users. A buttonbar is to the 
mouse what key-combination shortcuts are to the keyboard: it accelerates the application and facilitates
the access to the functionalities. Instead of browsing through the menus, you can quickly activate a 
command by simply clicking the appropriate button.

WizManager Buttonbar makes your work with File Manager easier. Tile horizontally or vertically, sort the
displayed files, exit File Manager, etc., with just the click of a button.

Windows for Workgroups introduced a buttonbar named the Toolbar, however WizManager Buttonbar 
outperforms it in nearly every aspect.    Give WizManager a try and you be the judge.    WizManager 
scrollable Buttonbar displays colorful buttons and lets you access all the File Manager functionalities. Its
customization is simple and allows you to display the buttons you want and in your preferred order. 

Files and directories can also be dragged and dropped onto the Buttonbar. The activated button on 
which the files and directories were dropped will automatically launch the corresponding File Manager 
or WizManager command.



Command Line Box
Added to the Buttonbar is another feature users have been waiting for: a Command Line Box. This 
Command Line Box is not the simple Run command found in the File menu. Most DOS internal 
commands and many external commands have been implemented in WizManager itself and are 
available directly within File Manager. 

'Old habits die hard...' this is especially true for many File Manager users who wish sometimes to 
quickly type DOS commands like DEL or COPY, start a program or open a file by simply typing its name
instead of using a mouse and menus. All this is now possible with WizManager Command Line Box. 
Because the Command Line Box is part of File Manager, all WizManager DOS commands are 
executed in Windows, without shelling out to DOS. The result could be called DOS in Windows: it is 
fast, convenient and powerful. With WizManager Command Line Box, the File Manager user gets the 
best of    both worlds:    Windows and DOS.    



Utilities
WizManager goes the extra yard.    WizManager adds many utilities which increase File Manager 
capabilities:

Frequently used functions or applications can be placed in a user customizable Launch pull-
down menu for fast and easy access. 

Pressing the right mouse button anywhere on File Manager displays a popup menu, listing all 
the currently active applications in Windows and enabling you to quickly switch to any of them. The popup
menu also displays your customized Launch menus and file commands such as Copy, Move, Delete, etc.

System information and disk information are made available. 
The system can be completely locked and restored after typing a user defined password. This 

feature permits you to leave your station, keeping information confidential or secure until you come back 
and enter your personal password.

A 'smart' association is integrated: with WizManager's Open Files you can open ALL (more than 
one at a time) the files selected in File Manager. In the displayed dialog box you can either view the file, 
open the files according to their associations (extensions), according to a specified association (for 
example, program associated with the TXT extension), or a specified program name (Browse to find 
application path, or enter it directly). All the files can also be sent to the same application. 

With the Print Directory utility you can print the displayed File Manager directory listing to a 
printer or to a file. Print Directory lets you either print File Manager selected files list or entire directory 
listings. WizManager also prints Search Result lists. A Print Tree utility is available as well.

Many other functionalities are available such as exiting or restarting Windows, rebooting the system, 
accessing the different Control Panel functions directly, Script files, File Viewer access, etc.



Launchbar
The Launchbar is a powerful tool and is like a Program Manager built-into File Manager. It allows you to
set buttons which will automatically launch DOS and Windows programs or open files.

Files can also be dragged and dropped onto the Launchbar. The application corresponding to the 
button to which the files were dropped to will automatically open the files.



To customize the Launchbar, select the Customize | Launchbar command from the WizManager 
menu. A duplicate of the Launchbar will be displayed. Select a button in the Launchbar whose relative 
position in the Launchbar you wish to change and drag it to its new location. Repeat with other 
Launchbar buttons until you are satisfied. 

To modify an existing button, click on it. A modify Launchbar Button dialog will be displayed which lets 
you customize the description, action and icon of the button. You can also add buttons to the Launchbar
by selecting the 'New Button' button.

The number of buttons displayed and the increment per scroll (number of buttons scrolled each time) 
can also be set in the Customize Launchbar dialog.




